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Notices 

Carefully read this manual so that you can properly use this product.
T&D Corporation accepts no responsibility for any malfunction of and/or trouble with 
this product or with your computer that is caused by the improper handling of this 
product and will deem such trouble or malfunction as falling outside the conditions for 
free repair of the attached warranty.

All rights of this User's Manual belong to T&D Corporation. It is prohibited to use, 
duplicate and/or arrange a part or whole of this User's Manual without the 
permission of T&D Corporation.
Microsoft® and Windows® are registered trademarks of Microsoft Corporation USA 
and are binding in the USA and all other countries.
Company names and product names are trademarks or registered trademarks of 
each company.
Specifi cations, design and other contents are subject to change without notice.
On screen messages in this manual may vary slightly from the actual messages.
Please notify the shop where you purchased this product or T&D Corporation of 
any mistakes, errors or unclear explanations in this manual. T&D Corporation 
accepts no responsibility for any damage or loss of income caused by the use of 
our product.
This product has been designed for private or industrial use only. It is not for use in 
situations where strict safety precautions are necessary such as in connection with 
medical equipment, whether directly or indirectly.
We are not responsible for any malfunction or trouble caused by the use of our 
product or by any problem caused by the use of measurement results of our unit. 
Please be fully aware of this before using our product.
Some of our products, which come under the category of strategic goods in foreign 
trade law, need the permission of the Japanese government to be exported outside 
of Japan.
The Manual itself can be downloaded from our Home Page: http://www.tandd.com/
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Software User Agreement

Escape Clauses
T&D Corporation does not guarantee the operation of RTR-50 for Windows®.
T&D Corporation shall not accept any responsibility for any damage, whether direct or 
indirect, that results from the usage of T&D Recorder for Windows.
Specifi cations of RTR-50 for Windows® may be subject to change and service may be 
terminated without advance notice to the user. In such a case, T&D Corporation shall 
not be responsible for any damages, whether direct or indirect, from the inability to 
use RTR-50 for Windows®.
T&D Corporation has no obligation to correct any defects found in RTR-50 for 
Windows.

Copyright
The Copyright for RTR-50 for Windows®, including the program and relevant 
documents, belongs solely to T&D Corporation.
The reprinting or redistribution for commercial purposes whether in part or in whole, in 
magazines or as a part of any product is strictly forbidden without the expressed 
consent of T&D Corporation. Any inquires concerning commercial redistribution 
should be directed to the Sales Department of T&D Corporation.
Please do not attempt to make any changes or modifi cations to RTR-50 for Windows®.
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To ensure safety be sure to obey all of the following warnings.

The following items should be strictly obeyed for the safe usage of this unit, 
and for protecting yourself and other people from bodily harm and/or damage 
to property. To ensure the proper use of our product, please read the following 
carefully and fully understand the contents.

Explanation of Symbols

Explanation of Warning Symbols

 DANGER

These entries are actions that absolutely under no 
circumstance should be taken. The taking of such 
an action may cause serious personal physical 
damage or death.

 CAUTION These entries are actions that if taken may lead to 
physical injury or damage to persons or things.

Explanation of Picture Symbols

Denotes an important warning or caution.

Denotes a forbidden action. Inside or near the symbol will 
appear another symbol giving details.

(EX : stands for DO NOT TAKE APART)

Denotes an action that you must take.
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DANGER

Be sure to follow the warnings and notices about use
from your PC maker when installing and using this unit.

Do not take apart, repair or modify the main unit.
Doing so may cause fi re or electrocution.

If water or a foreign body enters in this unit, turn the
power off and remove the batteries. Continued use may
cause fi re or electrocution.

Do not use this unit in wet or humid places, such as a 
bathroom.

Store RTR-50 main units, batteries and communication
cables out of the reach of children. 
It is dangerous to touch or swallow batteries.

Do not connect the communication cable to a telephone line. 
It may cause a fi re or other trouble including malfunction.

If any smoke or strage smells are emitted from the unit,
immediately remove the batteries and stop using.
Continued use may cause fi re or electrocution.

Do not drop the unit, or expose the unit to a strong
impact. If that happens to the unit, immediately turn the
power OFF and remove the batteries. 
Continued use may cause fi re or electrocution.
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CAUTION

This unit is not water-resistant.
If the unit gets dirty, wipe it with a clean cloth and a mild 
detergent.

Please do not insert your fi ngers or any foreign objects into any 
of the devices' jacks.

Battery terminals may provide insuffi cient contact due to age or
vibration.
This may lead to data loss.

Do not use any other batteries than those that are specifi ed in 
this User's Manual.
It may cause a fi re or other trouble including malfunction.

Battery terminals may provide insuffi cient contact due to
age or vibration. This may lead to data loss.

Condensation may occur if the unit is moved from one
environment to another where the difference in
temperature is great. Use the unit in an environment
where the ambient temperature is from -10 to 60  and the
humidity is 90  RH (no condensation) or less.
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Do not use or store the Thermo Recorder in any of the following
places. Doing so may cause electrocution, fi re and/or other
adverse effects to the device and/or your computer.
-   Areas exposed to direct sunlight

This will cause the inside of the device to become overheated 
and may cause fi re, deformation, and/or other damage 
including malfunction.

-   Areas prone to strong magnetic fi elds
This may cause damage including malfunction.

-   Areas exposed to water leakage
This may cause electrocution or other damage incluing 
malfunction.

-   Areas exposed to excessive vibration
This may cause injury, malfunction, damage or loss of proper 
electrical contact.

-   Areas near fi re or exposed to excessive heat
This may cause damage including malfunction and 
deformation.

-   Areas prone to smoke, duct and dirt
This may cause damage including malfunction.
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Wireless Regulations

Radio, EMC and Safety Regulations

This device complies with part 15 of the Federal Communications
Commision (FCC) rules and with RSS-210 of the Industry 
Canada (IC). 
Operation is subject to the following conditions:
(1) This device may not cause harmful interference, and
(2) This device must accept any interference received, including 

interference that may cause undesired operation.

Note:

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one or more of the following 
measures: 

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected.

- Consult the dealer or an experienced radio/TV technician for help.

The user is cautioned that changes or modifi cations not expressly approved by T&D 
Corporation, could void the user's authority to operate the equipment.
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1. Introduction
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What is Wireless Communication Port RTR-50?

The Wireless Communication Port RTR-50 is a base unit designed to carry 
out wireless communication with our compact waterproof Wireless Data 
Loggers, RTR-5 Series (RTR-51/52/53/RVR-52A) and to be connected to a 
computer via a USB or serial communication cable to gather data from and 
control the loggers. Also, by setting up an RTR-50 between the RTR-50 desig-
nated as the Base Unit and the RTR-5 Series Remote Data Logger unit, you 
can use any RTR-50 as a Relay Unit for wireless communication.

Application Examples
-  For the gathering of recorded data via wireless communication from long distances 

and the controlling of data loggers in places where handling of data loggers is diffi cult 
or impossible

-  For downloading recorded data and monitoring current readings from moving or 

rotating data loggers on production lines

* The communication range for each RTR-50 Relay Unit is up to 100m.
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What is RTR-50 for Windows®?

Outline

The easy-to-use software, RTR-50 for Windows® offers a variety of useful 
functions for any RTR-5 series data logger: including control of data logger 
recording settings, data downloading, graph display, table creation, printing, 
and fi le output.
Using our exclusive short-wave wireless technology it is possible to carry out 
Remote Unit Registrations and make Operational Settings between an 
RTR-50 Base and any RTR-5 Series Data Logger via wireless communica-
tion. If you wish to use an RTR-50 as a Relay Unit, it is also possible to carry 
out Relay Unit Registration and make other Operational Settings.

Basic Functions

Wireless Communication

Start Recording / Download Recorded Data / Monitor Current Readings / Warning Alarm 
/ Auto-Download / Get Remote Unit Status / Wireless Communication Test / Get Radio 
Wave Strength of Relay Unit / Get Remaining Battery Life in Relay Unit

Optical Communication---Carried out by placing a data logger (Remote 
Unit) face down on an RTR-50 (Base Unit).

Remote Unit Registration and/or Initialization / Start Recording / Download Recorded 
Data / Get Remote Unit Info

Direct Cable Communication---Communication carried out via cable 
between the computer and the Base Unit / Relay Unit(s) for the initial 
settings.

Relay Unit Registration and/or Initialization (Returning RTR-50 to Base Unit) / Relay 
Route Name Settings/ Communication Frequency Channel Settings / Get Remaining 
Battery Life 

Data Operation

- Easy processing of the data downloaded from a Remote Unit into graphs, saving to 
fi les and/or printing.

- Convert the Remote / Relay Unit Registration Info to fi le format.
- Display current measurements in graph form / Warning Status Log
- The downloading of data can be set to be automatically carried out at a specifi ed time 

or at a set interval of time. 
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Others

-Monitoring at each location for warnings is carried out and if any of the gathered data 
exceeds the set limit, a notifi cation can be sent via E-mail. 

To properly use this software, the following operational environment 
is necessary.

Compatible OS  Microsoft Windows® 98SE/Me (English)
 Microsoft Windows® XP/2000 (English)
Software Microsoft Internet Explorer ver.5.01 or higher
PC / CPU  IBM Compatible equipped with more than Pentium 

90MHz or NEC 98 Series
 USB Communication or Serial Communication (RS232-C 

D-sub 9pin)

Operating Environment A Stable Windows® Operating Environment
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Package Contents

The following items are included in the package:

Wireless Communication Port

RTR-50

Wireless Communication Port RTR-50 1

USB Communication Cable 1 Software
CD-ROM 1

Manual 1 Memo Sticker*1

*1:Please write Relay Unit Names, Numbers or any other memos on the sticker and 
fasten it to the unit.
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Part Names and Functions

Appearance Diagram

Front

Left Side / Right Side

Back
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2. Getting Ready

This section provides instructions on getting the RTR-50 ready to use.
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General Procedure

1. Install RTR-50 for Windows® into the computer. P.11

2. Connect the Communication Cable to the RTR-50.

When using the USB Communication Cable : 
Installing the USB Device Driver / 
Setting up the Communication Port

When using the Serial Communication Cable : 
Setting up the Communication Port

P.12～

3. Connect the Communication Cable to the Computer.

For Serial Communication install batteries or connect the AC 
adaptor in advance.

P.12～

4. Remote Unit / Relay Unit Registration, Various Settings by 
Optical Communication from RTR-50 for Windows.

P.28～

5. Remote Unit / Relay Unit Installation P.28～

6. Various Settings by Wireless Communication from RTR-50 for 
Windows

P.46～

7. Post-downloading Data Management and Processing in Graphs P.71～
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Getting Ready

Install Batteries
For serial communication with your computer and to use as a Relay Unit, make sure to 
install batteries.

NOTE:

When the RTR-50 is connected by a USB communication cable to your computer or 
power is supplied by an AC adaptor to the RTR-50, there is no need to insert batteries.

Insert 2 AA alkaline batteries as shown in the fi gure.

NOTE:

- Always use two batteries of the same type.

- Make sure not to mistake + / -.

- A battery cannot be charged inside the RTR-50.

*The Monitor LED will blink once when usable batteries are installed.
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Install RTR-50 for Windows® 

- Is Windows® operating properly

If Windows® is not operating properly, RTR-50 for Windows® may not be installed 
correctly or it may not operate properly.

- Please quit all other applications.

If you are running other applications, make sure to quit them before installation. If you 
have any permanently active software, such as a virus check or scan program in your 
computer, make sure to also quit it.

1. Open Windows
®
.

2. Insert the attached CD-ROM in the CR-ROM drive.

In a few seconds, the [Install Program] window will appear.

*If that window does not automatically open, please open it by double clicking the 
CD-ROM icon in [My Computer] on your desktop.

3. Select [RTR-50 for Windows
®
] and click the [Execute] button to start the 

installation.

4. Continue the installation by following the directions as they appear. 

After installation has been completed, "RTR-50 for Windows®" will be registered in 
Windows' [Start] Menu.
When connecting the RTR-50 to your computer for direct communication to download 
or make setting changes, etc , please use the USB communication cable (provided) 
or the optional serial communication cable (TR-07C). 
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Connect the RTR-50 with a USB communica-
tion cable to your computer 

1.  Connect the RTR-50 with the provided USB communication cable (US-15C) to 
your computer.

*It is not possible to simultaneously use both RTR-57U and RTR-50.

USB Port Mark

The USB communication cable is a USB-A plug  USB 
mini-B plug. Connect to a place with a mark as such.

* Make sure that the USB cable is inserted fully, so as not to cause an improper 
connection.

2. Install the USB Device Driver

* For details about the driver installation, see the next section.
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Installing the USB Device Driver

You will need to install this driver in order to use the device with a USB cable 
and Windows. The USB device driver must be installed for communication via 
USB between your computer and an RTR-50. After installing the USB device 
driver, your computer will be able to detect and recognize RTR-50 devices 
that have been connected with a USB cable.

For Windows® XP

1. Turn on your computer and open Windows. After Windows has been completely 
started up, connect the supplied USB cable to a USB port on the RTR-50 and 
your computer.

2. Insert the attached CD-ROM in the CR-ROM drive. If the Installation Window 
opens, close it.

3. By connecting an RTR-50 unit to the USB cable already connected to your 
computer, the [Found New Hardware Wizard] will automatically open.

4. By checking [Install the software automatically (Recommended)] and clicking [Next], 
the software will automatically be installed.

[Next] Button

5. After completing installation, click the [Finish] button.

Confi rm the Connections (See p.18).

If the Driver is not automatically detected

Please search by specifying the place as "[Device Driver \ RTR-50] in the CD-ROM 
drive" and install manually from there.
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For Windows® 2000

1. Turn on your computer and open Windows. After Windows has been completely 
started up, connect the supplied USB cable to a USB port on the RTR-50 and 
your computer.

2. Insert the attached CD-ROM in the CR-ROM drive. If the Installation Window 
opens, close it.

3. By connecting an RTR-50 unit to the USB cable already connected to your 
computer, the [Found New Hardware Wizard] will automatically open.

4. By clicking the [Next] button, a window will open where you can choose how you 
wish to fi nd the driver fi le.

[Next] Button

5. Check [Search for a suitable driver for my device (Recommended)] and click the 
[Next] button.

6. Check [CD-ROM drive] and then click the [Next] button.

7. Click [Next] to start the installation.

8. After completing installation, click the [Finish] button

Confi rm the Connections (See p.18).

If the Driver is not automatically detected

Please search by specifying the place as "[Device Driver\ RTR-50] in the CD-ROM 
drive" and install manually from there.
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For Windows® Me

1. Turn on your computer and open Windows. After Windows has been completely 
started up, connect the supplied USB cable to a USB port on the RTR-50 and 
your computer.

2. Insert the attached CD-ROM in the CR-ROM drive. If the Installation Window 
opens, close it.

3. By connecting an RTR-50 unit to the USB cable already connected to your 
computer, the [Add New Hardware Wizard] will automatically open.

4. By clicking the [Next] button, a window will open where you can choose how you 

wish to fi nd the driver fi le.

5.  Check [Automatic search for a better driver (Recommended)] and click the [Next] 
button.

Check [Next] Button

If the Driver is not automatically detected

Please search by specifying the place as "[Device Driver\ RTR-50] in the CD-ROM 
drive" and install manually from there.
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For Windows® 98SE

1. Turn on your computer and open Windows. After Windows has been completely 
started up, connect the supplied USB cable to a USB port on the RTR-50 and 
your computer.

2. Insert the attached CD-ROM in the CR-ROM drive. If the Installation Window 
opens, close it.

3. By connecting an RTR-50 unit to the USB cable already connected to your 
computer, the [Add New Hardware Wizard] will automatically open.

4. By clicking the [Next] button, a window will open where you can choose how you 
wish to fi nd the driver fi le.

5. Check [Search for the best driver for your device (Recommended)] and click the 
[Next] button.

Check

[Next] Button
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6. Place a check next to [Specify a location] and click the [Browse] button. Select 
"[Device Driver\RTR-50] in the CD-ROM drive" and click [Next].

Check [Next] Button

[Browse]
Button

7. After completing installation, click the [Finish] button

Confi rm the Connections (See p.19).

[Finish] Button
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Confi rming the USB Device Driver Connection 
to the Computer

Windows® XP / 2000

1. Open the [Control Panel] and double click on [System]; the [System Properties] 
will be displayed.

2. Click the [Hardware] tab, and click the [Device Manager] button in the [Device 
Manager] Area.

[Hardware] Tab

Device Manager

3. In the Device Manager Window, check to see if [USB Recorder 2] is listed under 
[USB Recorder 2 COM].

USB Recorder2

NOTE:

If the following tree items appear, see the "If USB Device Driver Installation Fails" 
(p.20).
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Windows® Me/98SE

1. Open the [Control Panel] and double click on [System], the [System Properties] 
will be displayed.

2. In the Device Manager Window, check to see if [USB Recorder 2] is listed under 
[USB Recorder 2 COM].

[Device Manager] Tab

USB Recorder2

NOTE:

If the following tree items appear, see the "If USB Device Driver Installation Fails" 
(p.20).
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If USB Device Driver Installation Fails

If, during USB device driver installation, some trouble occurs that results in a 
failure to install properly, the following display will appear in the Device 
Manager.

If this occurs, the USB device driver must be re-installed. Please follow the 
directions below to carry out the operation.

How to Re-install

1. In the Device Manager Window, right click on [USB Device] under [Other Devices] 
and then click on [Properties] to display the [USB Device Properties] Window.

2. In the [USB Device Properties] Window, click on the [Re-install Driver] button to 
display the Installation Window. Follow the directions to install.

[Re-install Driver] Button
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Connecting the RTR-50 with a serial commu-
nication cable to your computer 

1. Connect to your computer using the optional serial communication cable (TR-07C).

*It is not possible to simultaneously use both RTR-57U and RTR-50.

 Examples of Serial Port Symbols

The cable connection is a D-sub 9pin male.
Please connect to the place that has such a
symbol.

NOTE:

- Make sure to connect it to the correct place to ensure communication.
- Make sure that the cable is inserted fully, so as not to cause an improper 

connection.
- For Serial Communication make sure to insert 2 AA batteries or use the optional 

AC Adaptor (For details, contact your local representative or dealer.).

2. Make Communication Port Settings.

For details about Communication Port Settings, see the next page.
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Setting up the Communication Port

1. From the [Communication] Menu, select [Communication Port Settings].

2. Place a check next to: [Serial Communication] when communicating via serial 
communication cable, [USB Communication] when communicating via USB. Then 
click the [Auto Detect] button to automatically fi nd an RTR-50 using the currently 
set communication method (USB or Serial).

[Auto Detect]
Button

Check

3. After the search, if the message "Found RTR-50 Unit" appears in the [Detection 
Results] box, settings have been successfully completed. 

Click the [Close] button to close the Window.

NOTE:

- If the USB driver has not been properly installed, USB communication will not be 
possible. 

- If no port is detected, see [Troubleshooting] on page 107.
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3. How to use "RTR-50 for Windows"

This section guides you through how to use the software, 

"RTR-50 for Windows", included with each RTR-50 unit 

The software is designed to allow for easy data processing,

 creation of Graphs and management of all settings 

and registrations necessary to create Remote Units and Relay Units.
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Basic Functions

Open "RTR-50 for Windows"
From the list of programs in the Window's Start Menu, click on [RTR-50 for Windows] - 
[RTR-50 for Windows] to open.

Explanation of Display
"RTR-50 for Windows" Main Window

Settings 
AreaRemote Unit 

Group List

Remote Unit 
Properties

Menu Bar
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Menu Bar

[File] Menu

Open Temp/Humidity Graph / Open Multi-scale Graph / Open Event Viewer / Open 
Remote Registration File / Save Registration File as... / Quit 

[Communication] Menu

Wireless Communication:
Download Recorded Data / Start Recording / Monitoring/Warning Monitoring / 
Auto  Download / Get Remote Current Status / Wireless Communication Test

Optical Communication:
Download Recorded Data / Start Recording / Get Remote Unit Info / Communica-
tion Port Settings

[Settings] Menu

Monitoring:
Monitoring Graph Settings / View Warning Log / Warning Report Mail Settings / 
Mail Server Settings

Auto Download:
View Auto Download Log

Display Format Settings

[Registration] Menu

Remote Unit / Relay Unit Registration

[Help] Menu

Seach by Topic / RTR-50 for Windows Version Info / Main Unit Info

Remote Unit Group List

The Group and Remote Unit names will be displayed for all Remote Units that are 
registered to that Group in the [Remote Unit / Relay Unit Registration].
By right clicking on the Remote Unit icon, a menu will appear with commands for that 
type of unit.
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Remote Unit Properties (Remote Unit Info List)

View Remote Unit Info for the unit(s) selected from the Remote Unit List.
Unit Type --------------- The type of unit (RTR-51/52/53 or RVR-52A) for the selected 

Remote Unit(s) will be displayed.
Group Name ---------- The Group Name appears.
Com. Freq. Ch. -------- The Communication Frequency Channel for communication 

between the Base Unit and the Remote Units appears.
Remote Unit Name -- Displays the name of the selected Remote Unit.
Relay Route ----------- Displays the Name of the Relay Route via which the Remote 

Units communicate.
Route Com. Freq. Ch.

Displays the Communication Frequency Channel of the Relay 
Route via which the Remote Units communicate.

Relay Unit No. -------- Displays the No. of the Relay Unit via which the Remote Unit is 
connected.

Ch1 Upper Limit ------ Displays the Upper Limit set in [Monitoring / Warning Monitoring] 
for Warning Report.

Ch1 Lower Limit ------ Displays the Lower Limit set in [Monitoring / Warning Monitoring] 
for Warning Report.

Ch2 Upper Limit (For RTR-53 only)
Displays the Upper Limit set in [Monitoring / Warning Monitoring] 
for Warning Report.

Ch2 Lower Limit (For RTR-53 only)
Display the Lower Limit set in [Monitoring / Warning Monitoring] 
for Warning Report.

Monitoring Interval --- Displays the currently set Monitoring Interval.
Auto-Download ------- Displays the currently set Auto-Download Interval.

 Settings Area

There are four different types of Settings windows: [Download Data] tab, [Start 
Recording] tab, [Monitoring] tab, and [Auto-Download] tab.

Main Unit Info
Open the [Main Unit Info] in the [Help] menu to view the Version Info for the currently 
connected RTR-50 Unit. It is also possible to view the battery status in the RTR-50 Unit.
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Remote Unit / Relay Unit Registration

Basic Procedure for Registration

1. Connect an RTR-50 Unit with a USB or Serial communication cable to your 
computer.

*The default setting for an RTR-50 unit is as a Base Unit.

For details about connecting the RTR-50 with a USB communication cable to your 
computer see p.12. 
For details about connecting the RTR-50 with a Serial communication cable to 
your computer see p.21.

2. Register Remote Unit Name and Group Name.

Register all Remote Units to be placed.

For details about registering units as Remote Unit(s) see p.31.

3. Register Relay Unit Names and Relay Routes.

For details about Registering Relay Unit(s) see p.37.

NOTE:

There is no need to register a Relay Unit if there are no Relay Units between a 
Remote Unit and the RTR-50 Base Unit. However, if communication cannot be 
successfully carried out due to poor radio wave reception, please place Relay 
Unit(s) between the Remote Unit and the Base Unit.
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Image of Relay Unit Registration

Once the registration of a Relay Unit is complete, a Relay Unit Number will 
automatically be assigned to each Relay Unit.
Also, when carrying out Relay Unit Registration it is possible to assign a "Relay 
Route Name" that can be used to make sure that data is transmitted through a 
multiple number of Relay Units in the specifi ed route. 

NOTE : 

It is possible to set up so that more than one Relay Unit acts as a relay for the same 
Remote Units. However because wireless communication is carried out in Groups of 
Remote Units, the same Group will be relayed through different Relay Units causing 
ineffi ciency and an increase in the amount of communication time to more than 
necessary.
In order to reduce the communication time, please design Relay Routes so that a 
particular Group of Remote Units uses the same Relay Unit(s).
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NOTE : 

A Relay Unit Number will be automatically assigned to Relay Units in the order that 
they were registered to each Route.
When positioning the Relay Units, please keep in mind that communication is 
not carried out in order of distance from a Base Unit but rather in the numerical 
sequence of the Relay Unit's registration number, hence they should be placed in 
sequential order.

Example : 
Communication Sequence Order

Communication will occur sequentially from the fi rst Relay Unit as shown above.
If the Relay Units are not arranged in numerical sequence from the Base Unit, 
the communication route will be as seen below. This will cause not only the 
communication distance to increase but also the communication time to increase to 
longer than necessary.

4. After each Registration has been completed, please check the communication 
status by carrying out a "Wireless Communication Test."



31

Registering a Remote Unit

1. Connect the RTR-50 Main Unit with a USB or Serial Communication Cable to your 
computer.

2. In the Main Window, click [Registration] – [Remote Unit / Relay Unit Registration].

3. The [Remote Unit / Relay Unit Registration] display will be opened in a new 
window.

Group Name
Remote Unit Name
[New Registration] Button
[Get Settings] Button

Communication Frequency Channel

4. Place the Remote Unit (data logger) you wish to register face down on top of the 
RTR-50. After entering the Group Name and Remote Unit Name, click the [New 
Registration] button.

*Up to 8 characters can be entered for Group Name / Remote Unit Name.
A distinction will be made between upper and lower case alphabet. Ex. abc123 and 
ABC123 will be treated as different.
*In order to register a Remote Unit, it is also necessary to register a Group Name.
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5. When successful communication has occurred, the Remote Unit will be registered 
in the Registration List at the left side of the Main Window.

The registered 
Remote Unit

*The registered Remote Unit(s) will appear as [Group Name / Remote Unit Name].

6. Register Remote Units Sequentially.

Com. Freq. Ch. (Communication Frequency Channel)
- It is possible to set one Communication Frequency Channel (channel 0-21) to each 

Group.
- If no setting is made, an unused frequency channel will automatically be assigned. If 

there are no unused frequency channels, the channel that is used the least shall be 
automatically assigned.

- Communication Frequency Channel settings can only be made when registering a 
new Group. Once a Communication Frequency Channel setting has been made it 
cannot be changed.

[Get Settings] Button
Clicking this button will receive the Registration Info for already registered Remote Units 
(current settings).
Place the Remote Unit (data logger) for which you wish to receive settings face down 
on top of the Base Unit and click the [Get Settings] button.
When successful communication has occurred, the Group Name and Remote Unit 
Name will appear.
If you wish to register the currently displayed Remote Registration Contents without any 
changes, click the [New Registration] button to add the received registration info.
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Deletion and Initialization of Remote Unit
Registered Remote Units can be deleted, initialized, or deleted in Groups.
Click on the [Remote Unit] – [Remote Unit Info / Delete / Initialize] tab to open the [Remote 
Unit Info / Delete / Initialize] window.

Remote Unit Deletion

Select the Remote Unit to be deleted from the Registration List and click the [Delete 
Remote Unit] button.

Select the 
Remote Unit

[Delete Remote 
Unit] Button

Group Deletion

Select the Group to be deleted from the Registration List and click the [Delete Group] 
button.

NOTE:

By deleting a Group, it will become impossible to communicate with all Remote 
Units registered to that Group. If you wish to carry out communication with any such 
units they must be re-registered or initialized.

Select the Group

 [Delete Group] 
Button
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Remote Unit Initialization

Place the Remote Unit that you wish to initialize on top of the Base Unit connected to 
your computer and click the [Initialize] button.

[Initialize] Button

NOTE : 

- By initializing, all info saved in the Remote Unit will be erased and will be returned 
to as it was when it left the factory.
The Default Settings are Group Name: GROUP 1 / Remote Unit Name: Sr001 / 
Communication Frequency Channel: 0

- When initializing a currently registered Remote Unit, the Registration Info will also 
be erased from the Registration List.
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Getting Remote Unit Current Status (Wireless Communication)
It is possible to gather the current Remote Unit Recording Settings: Recording Mode / Type 
of Data / Recording Status / Current Readings / Radio Wave Strength / Battery Level by 
selecting [Get Current Status (Wireless)].

Recording Mode -- The selected recording mode will be displayed: Endless or One Time. 
Endless Mode:

When the logger has reached its maximum number of readings 
(16,000 readings possible / 8,000 of Temp and Humidity for 
RTR-53), the oldest data reading will be overwritten and recording 
will continue.

One-time Mode: 
Recording will automatically stop when the logger has reached its 
maximum number of readings (16,000 readings possible / 8,000 
of Temp and Humidity for RTR-53).

Type of Data ------- Temperature, Humidity, Voltage, Pulse, Event, Moisture can be viewed 
here.

Recording Status - Displays Recording in Progress, Waiting for Programmed Start or 
Recording Stop.

Current Readings - The currently recorded data is displayed here.
Radio Wave 
Strength ------------- Displays the Radio Wave Strength of wireless communication between 

Units. (0 – Weak < 5 – Strong)
Battery Level ------- The remaining battery level for the Remote Unit will be displayed. 

(0 – No Battery < 5 – Full)

1. Check if the Base Unit is properly connected to the computer.

2. From the Registration List, select the Remote Unit which you wish to view the 
Registration Recording Settings from and click the [Get Current Status (Wireless)] tab.

Select the 
Remote Unit

[Communicate] 
Button

 [Get Current Status (Wireless)] Tab

3. Click the [Communicate] button.

NOTE : 

If a communication error has occurred, please check the communication status by 
carrying out a "Wireless Communication Test." (See p.44 for details)
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Gettting Registration Info (Optical Communication)
It is possible to gather the current Remote Unit Info: Group Name / Frequency Channel 
/ Remote Unit Name / Registration Status by selecting [Get Registration Info (Optical)].

Group Name ----------Group Name will be displayed.
Com. Freq. Ch. --------Frequency Channel will be displayed.
Remote Unit Name --Remote Unit Name will be displayed.
Registration Status --Displays whether the Remote Unit has been registered in the 

Remote Unit Registration List or not.
 

1. Place the Remote Unit you wish to view the Registration Info from face down on 
the Base Unit that is connected to your computer.

2. Select the [Get Registration Info (Optical)] tab and click the [Get Unit Info] button.

[Get Unit Info] Button

[Get Registration Info (Optical)] Tab



37

Registering a Relay Unit

1. Connect the Relay Unit you wish to register to your computer with a USB or Serial 
Communication Cable.

2. Click the [Relay Unit] tab and enter a Relay Route Name. Then click the [New 
Registration] button.

Relay Route Name

[Memo] Area

[Relay Unit] Tab

[New Registration] 
Button

[Memo] 
It is helpful to make a memo entry here in order to distinguish between Relay 
Units.
(Up to 8 characters can be entered.) 
You may leave this fi eld blank if not necessary and should note that changes 
cannot be made after registering a Relay Unit. If you wish to make changes, it is 
necessary to create the Relay Route again.
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3. When successful communication has occurred, the Relay Route and Relay Unit 
will be registered.

*A Relay Unit Number for all registered Relay Units will be automatically assigned in 
the order that they were registered. (Not possible to change)

Registered Relay Route 
and Relay Unit

The registered Relay Unit and Remote Unit Group will appear in different 
background colors so as to be easily distinguishable.
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Connect a Remote Unit via Relay Unit

1. From the Registration List, select the Remote Unit which you wish to connect to 
the Base Unit via Relay Unit. Then drag the Remote Unit to the Relay Unit to 
which you wish to connect and drop it.

2. The message [Relay Settings for Selected Remote Completed] will appear and 
the Remote Unit will be added under the location in the Relay Route in the 
Registration List.

Removing a Remote Unit from a Relay Route

1. Select the Remote Unit which you wish to remove from the Relay Route. Then 
drag the Remote Unit to the Base Unit Icon and drop it.

2. The location of the Remote Unit will be returned just under the Base Unit in the 
Registration List.

*Also, by right clicking the mouse and then clicking on [No Relay], the location of the 
Remote Unit will be returned to the Base Unit as above.
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Deletion and Initialization of Relay Unit
Registered Relay units can be deleted or initialized.

Click on the [Relay Unit] – [Relay Unit Info / Delete / Initialize] tab to open the [Relay 
Unit Info / Delete / Initialize] window.

Relay Unit / Relay Route Deletion

Select the Relay Unit to be deleted from the Registration List. Click the [Delete Relay 
Unit] if you wish to delete only the Relay Unit and click the [Delete Route] if you wish 
to delete the Relay Route.

Select the Relay Unit

[Delete Route] 
Button

[Delete Relay Unit]
Button

NOTE : 

If you wish to delete a Relay Route, the location of all Remote Units belonging to it 
will be returned to just under the Base Unit in the Registration List.
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Relay Unit Replacement (For changing a Relay Unit with a new one 
due to malfunction or trouble)

Select the Relay Unit you wish to replace from the Registration List and connect the 
one you wish to newly register to your computer with a USB or Serial Communication 
Cable.
Click the [Replace Unit] button.

NOTE : 

The newly replaced Relay Unit will be registered with exactly the same registration 
contents as the old one.

Select the Relay Unit 

[Replace Unit] Button

Relay Unit Initialization (Returning to Base Unit)

Connect the Relay Unit you wish to initialize to your computer with a USB or Serial 
Communication Cable, and click the [Initialize] button.

[Initialize] Button

NOTE : 

By initializing all info saved in the Relay Unit will be erased and will be returned to 
as it was when it left the factory.
The default setting for an RTR-50 unit is as a Base Unit.
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Getting Relay Unit Current Status (Wireless Communication)
The Status of Relay Units which belong to the selected Relay Route will be gathered 
and displayed here.

Relay Unit Number -----The number of the Relay Unit will appear.
Radio Wave Strength --The Radio Wave Strength between Units will appear.

(0 – Weak < 5 – Strong)
*This is the Radio Wave Strength for wireless communication 
between a Relay Unit and the next Relay Unit with the 
previous number (located closer to the computer) or between 
the Relay Unit and the Base Unit.

Battery Level -------------The remaining amount of battery power will be displayed for 
the Relay Unit. (0 – No Battery < 5 – Full)

1. From the Registration List, select the Relay Route that contains the Relay Units 
from which you wish to get their Status.

2. Select the [Get Current Status (Wireless)] tab and click the [Communicate] button.

[Communicate] 
Button

[Get Current Status (Wireless)] Tab

Select the Relay Units

3. The communication results will appear.

NOTE:

If a communication error has occurred, please check communication status by 
carrying out the [Wireless Communication Test]. (See p.44 for details)
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Getting Base Unit / Relay Unit Info (Direct Communication)
It is possible to view the Relay or Base Unit Registration Info.

For the Base Unit

Battery Level -------------The remaining amount of battery power will be displayed for 
the Base Unit. (0 – No Battery < 5 – Full)

For a Relay Unit

Relay Route Name -----The name of the Relay Route to which the Relay Unit belongs 
will appear.

Com. Freq. Ch. -----------Communication frequency channel of Relay Route to which 
the Relay Units belong will appear.

Relay Unit No. -----------The number of the Relay Unit will appear.
Battery Level -------------The remaining amount of battery power will appear for the 

Relay Unit. (0 – No Battery < 5 – Full)

1. With a USB or Serial Communication Cable, connect the Relay Unit or Base Unit 
you wish to view the Registration Info to your computer.

2. Select the [Get Base / Relay Info (Direct)] tab and click the [Get Unit Info] button.

[Get Unit Info] Button.

[Get Base / Relay Info (Direct)] Tab

3. The communication results will appear.
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Wireless Communication Test

1. In the [Remote / Relay Unit Registration] window, click the [Wireless Communica-
tion Test] button.

[Wireless Communication Test] 
Button

2. Select the mode you wish to use for testing wireless communication from: 
[Test All Remote / Relay Units] / [Remote Unit Group] / [Relay Route] and then 
click the [Start Communication] button.

[Start Communication] Button

Test All Remote / Relay Units ------ The wireless communication test will be carried out 
for all registered Remote and Relay Units.

Remote Unit Group ------------------- The Radio Wave Strength for the Remote Units 
which belong to the Group selected from the 
Remote Group Name List will be displayed.

Relay Route ---------------------------- If you have checked "All Routes" in the [Select 
Route for Test] box, the Radio Wave Strength Test 
for all Relay and Remote Units that belong to each 
of the Routes will be carried out. If you have 
checked "Selected Route", please select the Relay 
Route for which you wish to carry out the Radio 
Wave Strength Test.
*A test for Remote Units which communicate 
directly with the Base Unit (no Relay Units) cannot 
be carried out here.
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3. A window will appear in which you can view the test results.

Test Results

--- Communication Successful The number of vertical lines shows 
the Radio Wave Strength. (Min:1 / Max:5)
If testing is of a Relay Unit, the Radio Wave Strength shown will be 
for between that Unit and the Unit with one number before it. (If the 
Relay Unit Number is 1 then the Strength shown will be for 
communication with the Base Unit).

--- Communication Failure Appears in front of the Remote or Relay 
Unit Name for which a communication failure has occurred.

--- Appears in front of the Remote or Relay Unit Name for which the 
test has not been selected in the test mode (communication does 
not occur).

* If a communication failure has occurred, check the Relay / Remote Unit location 
and the remaining battery life.
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Data Download Settings

Data Download Settings for each Remote Unit or for a Group at Once can be 
made in the Main Window.

1. When downloading data from one Remote Unit, in the Remote Unit Group List at 
the left side of the window select the Remote Unit from which you wish to 
download data. When downloading data via a Group, in the Remote Unit Group 
List select the group folder which you wish to download from.

Select the 
Remote Unit Group

or Remote Unit

[Download] 
Button

[Detailed Settings]
Button

2. By making Communication Method and Downloading Settings and then clicking 
the [Download] button, downloading will begin. During download, the current 
downloading progress will appear in the [Downloading Status Box] of the Main 
Window.

Group / Remote Unit (Only for Wireless Communication)

Only Selected Remote
Download only that data saved in the one selected Remote Unit from the [Remote 
Unit Group List].
 
Group at Once
Download all data saved in the Remote Units belonging to the selected Group in the 
[Remote Unit Group List].

NOTE:

*The downloaded data will be automatically saved in a fi le with the following format 
"Group Name_Remote Unit Name _Date / Time.ext" in the same Folder into which 
RTR-50 for Windows was installed.
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Downloading Range
All Data --------------------Download all data saved in the Unit.

Specify Data by time ---Download only that data recorded during a specifi ed period 
back from the last recorded data reading. You can specify the 
periods in units from 1 hour or from 1 day. If a period is 
specifi ed that includes a time of data that is not saved in the 
Unit, all data will be downloaded. 

Downloading Status (Info for the Group or Remote Unit from which 
data is being downloaded will appear.)

Group Name -------------Displays the Group Name in which the Remote Unit belongs.
Remote Unit Name -----Displays the Remote Unit Name from which data is being 

downloaded.
Starting Method --------- Immediate Start / Programmed Start
Recording Mode --------Endless / One Time
Start Date / Time --------Displays the date and time when recording was started.
Recording Interval ------Displays the set recording interval.
Type of Data --------------Temperature / Humidity / Voltage / Pulse / Event / Moisture

NOTE:

- Only when using optical communication will the downloading progress bar show the 
percent of data downloaded as it occurs.

- If it is waiting to start a programmed recording, an error message will appear saying 
there is no data.

- Recording of data will continue during downloading and after downloading has 
been completed. The data recorded in a Remote Unit is erased when a new 
recording is started.

- The data recorded in a Remote Unit is erased when a new recording is started. The 
downloaded data is also erased when the software is closed or the computer is 
turned off. Therefore, we suggest saving the data to a fi le as soon as possible.

- If the amount of battery life is low or if on the LCD display of the unit the BAT mark 
appears, please replace the batteries as soon as possible.
All recorded data may be erased when the batteries are changed and the unit 
automatically resets. Before replacing the batteries please make sure to download 
any necessary data and save it in a fi le.

- When communicating via USB, if a forced cancellation occurs in the application 
while downloading of data is in progress, USB Communication may become 
jammed and unstable. If this is the case, insert the USB cable again.
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[Detailed Settings] Button
Here, it is possible to make Pre-Downloading settings and settings for the processing of 
downloaded data to be followed after downloading has been completed.

[OK] Button

Check the desired items and click the [OK] button to fi nish the settings.

Pre-Downloading Settings
Calculate time to complete communication.
 These settings are only for when communicating via Relay 

Unit(s). If a check has been placed in the checkbox, the total 
time for a wireless communication session to be completed will 
be displayed in the [Communication Status] Dialog Box. Note 
that in order to display the time to complete the communication 
it is necessary for the Remote Unit to carry out one communica-
tion with the Relay Unit(s) before the start of downloading. The 
approximate time for that communication is calculated as 
follows: (Number of Relay Units x 20 seconds). This time will be 
added to the time for the downloading of data itself. The total 
communication time is the sum of "the added time as calculated 
above" and "the actual time that the download will take". If you 
wish to view the estimated time to complete a communication, 
place a check in the box.
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Post Downloading Settings
Automatically show graph.

Downloaded data will automatically be displayed in graph form. 
If you wish to save data, go to the [File] Menu in the Graph 
display to save it.

Assign a File Name for the saved data.
After data has been downloaded from the Remote Unit, the [Save 
File] dialog box will appear wherein you can save the data to a 
specifi ed fi le. Please assign a fi le name for the saved data. The 
saved data can be viewed in a Graph form later. (See "Chapter 
4 Graph Operation" for details.)

Assign a File Name for the saved data and automatically show graph.
"Assign a File Name for the saved data." and "Assign a File 
Name for the saved data and automatically show graph." written 
above will be carried out in order.

Assign a File Name to each Remote one by one and save the fi le in the 
specifi ed data storage folder.

After downloading data, the data will automatically be assigned 
a File Name (Group Name / Remote Unit Name / Date Time. 
Extension) and stored in the specifi c Folder. Even if the settings 
for the data storage folder have not been made here, that fi le 
will automatically be stored in the same Folder into which the 
application was installed. The saved data can be viewed in a 
Graph form later. (See "Chapter 4 Graph Operation" for details.)
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Recording Start Settings

You can make Recording Start settings via Wireless or Optical Communica-
tion.
Click on the [Start Recording] tab to open the [Start Recording] window.

When using Wireless Communication
[Start Recording] Tab

[Start Recording] 
Button

[Get Settings] Button

[Stop Recording] 
Button

1. When making Start Recording settings for one Remote Unit, select the Remote 
Unit for which you wish to make Start Recording settings from the Remote Unit 
Group List at the left side of the window. When making Start Recording settings 
for Group at once, select the group folder for which you wish to make Start 
Recording settings from the Remote Unit Group List at the left side of the window.

2. Make the desired settings and click the [Start Recording] button.

The confi rmation message dialog box will appear. Click the [OK] button to send 
the settings to the Remote Unit(s) and then start recording. (If you do not wish to 
have the dialog box displayed, check [Do not show this message the next time a 
recording session is started.].) It is possible to return the hidden confi rmation 
message to view by holding down the <Shift> key and right clicking with the mouse 
in the empty area. Then this message will appear again the next time a recording 
session is started.

[Start Recording] Button

Recording will start for the one selected Remote Unit.
*If the Remote Unit has been set for [Forbid Recording Start via Wireless 
Communication], [Start Recording] cannot be carried out. See the "[Detailed 
Settings] button" (p.55) for details.

[Get Settings] Button

Receive and Display the current settings from the selected Remote Unit.
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[Stop Recording] Button

By clicking you can stop the recording of the selected Remote Unit or Group at any 
time during recording.

*If the Remote Unit has been set for [Forbid Recording Start via Wireless 
Communication], [Start Recording] cannot be carried out. 
For more details, see the User's Manual that accompanies the Remote Unit.

Recording Device Selection (Only for wireless communication)

Group -------------------Displays the Group Name selected from the [Remote Unit Group 
List].

Remote Unit -----------Displays the Remote Unit Name(s) selected from the [Remote 
Unit Group List].

Only Selected 
Remote -----------------Starts the recording of one selected Remote Unit.
Group at Once --------Starts recording of all registered Remote Units in the selected 

Group.

Recording Start Date / Time

Programmed Start ---The Remote Unit will begin recording at the time and date 
programmed. Enter the hour, minute and second of the date, 
month and year you wish to begin recording. Upon opening the 
dialog box the fi rst time, the default setting will be the time and 
date it was opened. (The default setting will round up to the 
nearest minute)
When making settings for the date and time to start recording 
under a programmed start, make sure to take into account the 
time necessary for wireless communication between the 
Remote Unit(s) and the Base Unit to occur. 
A Programmed Start can not begin if the Programmed Start 
Time has been set to a time that is before wireless communica-
tion can be completed with all units in the Group. (An Error 
Message will appear.) As a general rule the amount of time 
necessary to start communication for each route should 
probably take (the number of Relay Units in the route + 1) 
multiplied by 20 seconds. Also, if Remote Units which 
communicate via different numbers of Relay Units and one 
which communicates directly with the Base Unit are mixed when 
starting a recording session via Group, please make settings for 
the Programmed Recording Start Time using the amount of time 
calculated for the Remote Unit that communicates via the 
largest number of Relay Units.
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Present 
Date / Time ------------The time set in your computer's system will appear here. If you 

have selected a Programmed Start, the Recording Start Time 
must be set to a time coming after the present time.

Est. Finish 
Date / Time ------------The fi nish date and time of recording will be automatically 

calculated from the set recording interval and starting time. (If 
you are recording under the Endless Loop method this will not 
appear.)

Recording Interval

Selection can be made from any of the following: 
1, 2, 5, 10, 15, 20, 30 seconds or 1, 2, 5, 10, 15, 20, 30, 60 minutes.

Recording Mode

One-time Mode -------With One-time Mode, upon reaching capacity of 16,000 readings 
(8,000 of Temp and Humidity for RTR-53), "FULL" will appear on 
the LCD display and recording will automatically stop.

Endless Mode --------With Endless Mode, when the number of recorded readings 
reaches 16,000 (8,000 of Temp and Humidity for RTR-53), the 
oldest data readings will be overwritten and recording will 
continue.
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When using Optical Communication

Measuring Mode

[Detailed Settings] 
Button

[Stop Recording] Button
[Get Settings] Button
[Start Recording] Button

[Moisture Probe 
Settings] Button

1. Select the Unit Name.

*If you select RVR-52A, the setting items for the Measuring Mode will appear.

2. By clicking the [Detailed Settings] button which appears only when using optical 
communication, the [Wireless Communication Protection] display will appear. 
(See p.55 for details)

3. Make the desired settings and click the [Start Recording] button to fi nish.

[Start Recording] Button

Clicking here will start a recording session for the Remote Unit using all of the set 
recording conditions.

*If you choose to hide a confi rmation message, by holding down the <Shift> key, 
right click with the mouse in the empty area and this message will appear again the 
next time a recording session is started.

[Get Settings] Button

Receive and display the settings of the Remote Unit that is currently placed on the 
Base Unit.

[Stop Recording] Button

By clicking, you can stop the recording of the Remote Unit that is currently placed on 
the Base Unit.
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Recording Start Date / Time

Programmed Start --The Remote Unit will begin recording at the time and date 
programmed. Enter the hour, minute and second of the date, 
month and year you wish to begin recording. 
Upon opening the dialog box the fi rst time, the default setting 
will be the time and date it was opened. 
(The default setting will round up to the nearest minute.)

Immediate Start ------The Remote Unit will begin recording immediately. There is no 
need to make the recording start date and time settings.

Present 
Date / Time ------------The time set in your computer's system will appear here. If you 

have selected a programmed start, recording start time must be 
set at a time following to the present time. 

Est. Finish 
Date / Time ------------The fi nish date and time of recording will be automatically 

calculated from the set recording interval and starting time. 
(If you are recording under the Endless Loop method this will not 
appear.)

Recording Interval

Selection can be made from any of the following: 
1, 2, 5, 10, 15, 20, 30 seconds or 1, 2, 5, 10, 15, 20, 30, 60 minutes.

Recording Mode

One-time Mode -------With One-time Mode, upon reaching capacity of 16,000 readings 
(8,000 of Temp and Humidity for RTR-53), "FULL" will appear on 
the LCD display and recording will automatically stop.

Endless Mode --------With Endless Mode, when the number of recorded readings 
reaches 16,000 (8,000 of Temp and Humidity for RTR-53), the 
oldest data readings will be overwritten and recording will 
continue.
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[Detailed Settings] Button (For optical communication only)

Forbid Recording Start via Wireless Communication

If a Remote Unit has been set for [Forbid Recording Start via Wireless Communica-
tion], the starting / stopping of recording via wireless communication will not be 
allowed for that Remote Unit. Also, makes impossible the stopping of recording via 
wireless communication.

Permit Recording Start via Wireless Communication

If a Remote Unit has been set for [Forbid Recording Start via Wireless Communica-
tion], clicking here will allow the starting / stopping of recording via wireless 
communication.

NOTE : 

By click the [OK] button, the settings will become effective the next time the 
recording is started via optical communication.

Measuring Mode (For optical communication only)
*Appears for RVR-52A only.

Voltage 
(The unit of measurement on the display will show [V] for Voltage.)

Instantaneous Value ---Records the voltage at the instant of measurement.
Preheat Time ----------When recording Voltage using the instantaneous value 

method. The choices for the preheat time setting are 
"deactivate", "50 msec", or from "1 to 200 seconds" in units of 
one second. If the sensor you are using needs power, it is 
possible to make settings to allow for a specifi ed preheat time.

Average Value -----------Records the voltage as a value of the average of the 
measurements within a specifi ed recording range.

Pulse 

Falling -------------------Records falling pulse edge.
Rising -------------------Records rising pulse edge.

Event 
(The unit of measurement on the display will show (Hi or Lo) to 
signify an event.)

Records the time of a pulse event.
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Moisture 
(The unit of measurement on the display will show [P] for Percent.)

It is possible to measure soil moisture using Decagon Devices Inc, Soil Moisture 
Sensor ECHO Probes (EC-10, EC-20). T&D Corporation does not handle or sell the 
Soil Moisture Sensors ECHO Probe (EC-10, EC-20). All inquires and questions 
concerning sales of and the operational specifi cations of the sensors should be made 
to Decagon Devices Inc. [http://www.decagon.com].
Record Moisture by Percentage.
*When measuring moisture with the RVR-52A, it is necessary to make sensor 
settings in [Settings] – [Moisture Probe Settings] or [Moisrure Probe Settings] button. 

[Moisture Probe Settings] Button (For optical communication only)

If you have selected "Moisture" as the Measuring Mode, then here you should set into 
the Data Logger the moisture percentage calculation equation for the moisture sensor 
you are using.

Probe
Settings

Moisture
Adjustment

[Get Settings]
Button

[Send Settings]
Button

[Use Adjustment in Equation] Button

Probe Settings
Select which sensor you are using, either EC-10 or EC-20 and click the [EC-xx 
Default Values] button and [Send Settings] button for that sensor.

EC-10 Default Values: Y = 0.0936  X - 37.6
EC-20 Default Values: Y = 0.0695  X - 29

NOTE : 
For more details about these values, please see the User's Manual that came with 
your sensor. 

[Get Settings] Button
This allows you to gather the equation that is currently set in the RVR-52A logger. 
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[Send Settings] Button
This sends the currently displayed moisture percentage calculation equation to the 
RVR-52A logger. 
* Before sending settings, use the [Get Settings] button to receive the current settings.

Moisture Adjustment

Before making adjustments, use the [Get Settings] button to receive the current 
settings. 
By placing a check next to [Make Adjustments], it is possible to make corrections for 
measurement errors that may occur. 
This function allows you correct or adjust for errors in measurement values. The Data 
Logger will record only the adjusted value. 
 Current Reading: Enter the actual measurement before adjustment
 Post-adjusted Reading:  Enter the desired measurement after adjustment.

[Use Adjustment in Equation] Button
The newly adjusted equation will appear in the Moisture Percentage Calculation 
Equation Area. 

[Send Settings] Button
The adjusted equation will be sent to the Data Logger. 

NOTE : 

- When you are carrying out adjustments and formulating equations please take 
care with the settings and take personal responsibility for the process.

- We cannot guarantee that after carrying out adjustment the measuring accuracy 
will improve for all measuring ranges. 

- For details about Moisture Adjustment, see the [Help Menu] in the provided 
software T&D Recorder for Windows® .
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Monitoring / Warning Monitoring Settings

It is possible to monitor and view current readings in a new window.
Click on the [Monitoring] tab to open the [Monitoring / Warning Monitoring] 
window.
Select the Remote Unit or Group to be monitored from the Monitoring Info 
List.

Monitoring Info List

[Start Monitoring / Warning Monitoring] 
Button 

[Monitoring Interval] Button

[Warning Report Mail Settings] Button
[View Warning Log] Button

Monitoring Info List

Group Name ---------- Displays the Group Name registered.
Remote Unit Name -- Displays the Remote Unit Name registered.
Upper Limit 1 ---------- Displays the Upper Limit setting for the Warning Monitoring of 

Channel 1.
Lower Limit 1 ---------- Displays the Lower Limit setting for the Warning Monitoring of 

Channel 1.
Upper Limit 2 ---------- Displays the Upper Limit setting for the Warning Monitoring of 

Channel 2.
Lower Limit 2 ---------- Displays the Lower Limit setting for the Warning Monitoring of 

Channel 2.
Monitor ----------------- Check the Remote Unit to be monitored.

[Monitoring Settings]

Monitor

Operates simultaneously with Monitoring Info List. Place a check to make changes to 
the Monitoring settings for the specifi ed Remote Unit.

Interval

Displays the Monitoring Interval set in the [Monitoring Interval Settings] dialog box. 
The set Monitoring Interval will become the common one for all Groups.
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[Monitoring Interval] Button
It is possible to specify the monitoring interval. 
Check [Monitor] and click the [Monitoring Interval] button to make monitoring interval 
settings.

 NOTE:

If you wish to set the monitoring interval in units of seconds, please assign a value of 20 
seconds or higher, and if units of minutes, assign a value of 1 minute or higher. 
Also please assign an interval time that is longer than communication time necessary for 
the currently selected Remote Unit(s).

[Warning Settings]
When making upper and lower limit settings for Warning Report, select the Remote Unit 
from the Monitoring Info List, select the unit of measurement, make a check next to 
Ch.1 or Ch.2 and enter the desired values. Click the [Apply] button to save the settings.

[Warning Report Mail Settings] Button
When current readings have exceeded upper and lower limit settings, a warning report 
mail can be sent. Check [Send a Warning Report Mail automatically if a Warning 
occurs], and click [OK]. 
Make any necessary mail settings in the [Mail Settings] window.
*For details about Mail Settings, see p.65.
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[View Warning Log] Button
If a warning has occurred, it is possible to view all warning records in this log.

Warning Log Window

Warning Time ---------View the time of warning occurrences.
*The Dates and Times shown here are those for when a warning 
monitoring communication was completed. They are different 
from the time when the warning actually occurred.

Group Name ----------View the Name of the Group for which the warning occurred.
Remote Unit Name --View the Name of the Remote Unit for which the warning 

occurred.
Warning Value --------View the measurement readings which have exceeded the limit 

settings.
*The Warning Values shown here are those for when a warning 
monitoring communication was completed. Even if data has 
been transferred and exceeded the set limit during a 
communication session other than for monitoring, it is not 
refl ected as Warning Value.

NOTE:

The Warning Log can hold up to 1000 records. If warning occurrences exceed 
1000, a fi le with the following format "Current Time + WarningLogList.wlf" will be 
automatically created in the folder where the application has been installed. The 
current Warning Log in the window will be cleared and the new Warning Log will be 
displayed from the top. If you wish to refer to a previous Log, click the [Open Log] 
button and select that Log fi le. If you wish to save a Log, click [Save Log] and save 
the contents to the fi le.
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[Start Monitoring / Warning Monitoring] Button
Opens the [Monitoring Graph] in a new window with all settings previously made by 
clicking this button.

NOTE:

Clicking the [Start Monitoring / Warning Monitoring] button opens the [Monitoring Graph] 
in new windows for the number of Groups you have registered.

Monitoring Graph Window
By making the desired settings in the [Monitoring / Warning Monitoring] window and 
then clicking the [Start Monitoring / Warning Monitoring] button the [Monitoring Graph] 
window will be opened in a new window.

NOTE:

Opens the [Monitoring Graph] in a new window for the number of Groups you have 
registered. 

[Stop] Button

Remote Unit 
Name

Group Name

The Group Name will be displayed in the window title area.

NOTE:

- Do not make any changes to the Remote Registration Contents during Monitoring.

- Other communication cannot be carried out during a monitoring session. Click the 
[Stop] button once before closing the [Monitoring Graph] window.

- If Auto-Download has started during a monitoring session, Monitoring and Warning 
Monitoring will be temporarily stopped and be started again upon the completion of 
the Auto-Download session.
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[Stop] Button

Click to stop the current Monitoring / Warning Monitoring. Clicking the [Stop] button in 
a window stops Monitoring / Warning Monitoring for all groups in which it is currently 
being conducted. 

*It is not possible to stop Monitoring / Warning Monitoring for only one window.

Monitoring Graph Settings
It is possible to make all the necessary view settings in the [Monitoring Graph] 
window.

Remote List 
View

Data View Graph View

Click [Monitoring Graph Settings] in the [Settings] Menu.
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Remote Unit List View Settings
Make changes to the Remote Unit List settings.

Font Color ----------------Set font color.
Background Color ------Make background color settings.
Warning Button Color --Make warning button color settings.
Font Size ------------------Set font size.
Preview --------------------The current settings for the [Remote List View], [Data List 

View] and [Graph View] can be viewed in the Preview Display.
*Clicking on each list can shift the display to view the desired settings display.

Data List View Settings
Make changes to the Data Display Area settings.

Current Data Settings
Data Color ----------------Make character color settings for the display of current data.
Warning Data Color ----Make character color settings for warning data.
Font Size ------------------Make settings for font size of the current data.

Remote Unit Name Settings
Data Color ----------------Make settings for Remote Unit Name character color.
Font Size ------------------Make settings for font size of the current data.
Background Color ------Make settings for background color in the data display area.
Preview --------------------The current settings for the [Remote List View], [Data List 

View] and [Graph View] can be viewed in the Preview Display.
*Clicking on each list can shift the display to view the desired settings display.
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Graph View Settings

Graph Color Settings
Line Color 1 / Line Color 2 ---Make settings for the color of that channel's data lines in 

the graph. Line Color 1 is for Remote Unit Ch.1 and Line 
Color 2 is for Remote Unit Ch.2 (for RTR-53 only). Each 
click of the [ ] button will make that channel's line 
thicker and each click of the [ ] button will make it 
thinner.

Background Color -------------Make settings for the graph's background color.
Vertical Background Color ---Make background color settings for the vertical axis.

Graph Display Size Settings
Auto Setting -------------- In one window display the graphs for the number of Remote 

Units in which monitoring is being carried out by changing the 
height of each graph.

Manual Setting (%) -----Display the size of one graph in proportion to the currently 
used window size (height).
*For example, if the height of the currently used window is 
400, by making the settings 50%, the height of the graph 
display will be 200. It is possible to scroll up and down to bring 
all graph displays into view. However, if the total height of all 
graph windows is smaller than the currently used window size, 
the height of the graph at the bottom will be automatically 
enlarged to fi ll up the window.

Displayed Data ----------The number of data points to be displayed in the Graph for 
one channel.
*Graph lines will not be displayed for any period when 
Monitoring resulted in a failure.

Preview --------------------The current settings for the [Remote List View], [Data List 
View] and [Graph View] can be viewed in the Preview Display.

*Clicking on a list will shift the display to view the desired settings display.
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Mail Server Settings
Here is where all settings for sending warning report E-mail can be made.
Click [Mail Server Settings] in the [Settings] Menu.

Mail Server Settings Window

NOTE:
- In order to send E-mails, it is necessary to have set up a SMTP server (for 

sending) and a POP3 server (for receiving) in the network. Also, a Mail Account 
Name, User Name and Password are needed. A POP3 sever can only be used 
when the POP before SMTP settings have been set as active. Please contact your 
local provider for more details.

- The encryption of content is not supported.
- Because no Dialup Connection Settings have been made, to have warning 

report mails sent automatically, you must be connected to the Internet (normally 
connected).

Receiving Server (POP3) --If the POP before SMTP setting has been set to active, 
enter the POP3 server you wish to use to send E-mail.

Sending Server (SMTP) ----Enter from which SMTP server you wish to send E-mail.
E-Mail Address ---------------Enter the mail address to which warning report mails 

should be sent.
User Name --------------------If the POP before SMTP setting has been set as active, 

enter the User Name and Password for your mail account.
Password ----------------------If the POP before SMTP setting has been set as active, 

enter the User Name and Password of your mail account.
Save the Password ----------By checking this button, the Password will be saved. POP 

If the POP before SMTP setting has been set as active, 
place a check in the box to save the Password.

Activate POP before SMTP------The POP before SMTP settings will be set to active.
*The POP before SMTP settings vary depending upon 
your server. Please contact your local provider for more 
details.

Subject -------------------------Enter a subject name for the E-mail. (OK to leave blank)
Content -------------------------Enter any comments which you wish to appear in the 

upper part of the warning display. (OK to leave blank)
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Auto-Download Settings

Auto-Download Settings can be made in the Main Window. Click on the 
[Auto-Download] tab to open the [Auto-Download] window.
Select the Remote Unit or Group for which you wish to carry out Auto-down-
loading from the Auto-Download Info List.

Auto-Download Info List

[Start Auto-Download] Button 

[Data Storage Folder] Button

[View Auto-Download Log] Button

Auto-Download Settings 

[Auto-Download Settings]

1. Check [Carry out].

2. Select the download interval.

Every Day at Fixed Time -- Download data automatically every day at a fi xed time.
Fixed Interval ---------------- Download data automatically at a fi xed interval of time.

3. Specify Period for Downloading.

Specify by Time ------------- Select this if you wish to download only part of the data 
by specifying to download only data recorded from a 
set number of hours before the present time. If a period 
of time is selected which is larger than that of the actual 
recorded data, all data will be downloaded.

All Data ------------------------ Select this if you wish to download all of the data that is 
recorded in the Remote Unit(s).

4. Click the [Apply] button to apply the settings. You can view the current settings in 
the Auto-Download Info List.
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[Start Auto-Download] Button
Clicking this button will start the Auto-Downloading of data. 
Click the [Start Auto-Download] button.

*If you wish to make the same Auto-Download settings for all registered Remote Units in 
all Groups, check [Common for All Groups].

NOTE:

If Auto-Download has started during a monitoring session, Monitoring and Warning 
Monitoring will be temporarily stopped. They will be started again upon the fi nishing of 
the Auto-Download session.

[Data Storage Folder] Button
When using Auto-Download, specify the folder into which the data fi le should be saved.

NOTE:

- Specify the folder into which the data will be saved for each Group.

- If you do not specify the data storage folder, the data will be saved in the same 
folder where RTR-50 for Windows was automatically installed.
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[View Auto-Download Log] Button
View the Auto-Download Log (the time and result of downloading).

NOTE:

An Auto-Download Log can hold up to 1000 records. Upon exceeding 1,000 records, 
the log stored in the RTR-50 will be automatically erased. If you wish to save the 
Log, click the [Save Log] and save the contents to a fi le.

 

Auto-Download Log Window

[Open Log] Button

[Save Log] Button

[Clear Log] Button

Auto-Download Log

Gathering Date/Time ---------View the Date and Time of Auto-Downloading.
Group Name --------------------View the Name of the Group for which the Auto-Down-

loading has been completed.
Remote Unit Name ------------View the Name of the Remote Unit(s) for which the Auto-

Downloading has been completed.
Results ---------------------------A Successful download returns a blank and failed 

download returns "Failure".

[Open Log] Button

Open existing Log Files (fi le extension "glf").

[Save Log] Button

Save the data in the current display to the desired location.

[Clear Log] Button

Clicking this will delete all records from the currently selected log and the display will 
be refreshed.
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4. Graph Operations

Here operations can be carried out to view in graph form the data recorded 

by RTR-5 Series Data Loggers. 

Depending on the type of data, from the [File] Menu, 

select one of the commands [Open Temp/Humidity Graph], 

[Open Multi-scale Graph], or [Open Event Viewer] to open a graph.
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Temperature / Humidity Graph

Here operations can be carried out to view in graph form the temperature and 
humidity data recorded by RTR-5 Series Data Loggers.
From the [File] Menu, select [Open Temp/Humidity Graph] to open.

*If a check has been placed next to [Automatically show graph] in ([Download Data] tab 
– [Detailed Settings] – [Post Downloading Settings]), the graph will automatically be 
displayed after downloading. (The default setting is for a check to be next to [Automatically 
show graph].)

Main Window Names and Functions
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1.Graph Area
The area in which the Graph is displayed. The horizontal axis shows time and the 
vertical axis shows temperature / humidity data.

2.A and B Cursor Bars
By clicking the arrow buttons at the left and right of the bar, you can simultaneously 
move the A/B cursors. Click and drag the [A] or [B] button on the bar to move the 
cursor to the left or right. 

3.A and B Cursor Position Information
The approximate date and time for the A and B cursor positions and the time 
difference between the A cursor and the B cursor is displayed.

4.Channel Info Display
The detailed data info for each channel 1 to 8 is displayed below the Graph Display. 
See the next page for details.

5.Menu Bar
Click on the desired menu in the Menu Bar to set or display each function from which 
you can choose from an array of commands.

6.Toolbar
Buttons appear for frequently used commands.

7.Horizontal Gauge Bar and Button for Moving Horizontal Axis
By dragging the gauge you can move left and right to the data you want to be 
displayed. The time axis moves by clicking these arrow buttons.

8.Vertical Gauge Bar and Button for Moving Vertical Axis
By dragging the gauge you can move up and down to the data you want to be 
displayed. The vertical axis moves up or down by clicking these arrow buttons.

Channel Info Display Items

ch [Channel Number] button. Drag the channel name / number you wish to 
move to the newly desired channel name / number position and drop it.

Name Channel Data Name Interval Recording Interval

Sample Number of data CursorA Cursor A position data

CursorB Cursor B position data A<->B Calculated Temp / Humidity 
Difference between Cursor A 
and B

High Highest Reading Low Lowest Reading

Avg. Average Reading Unit Unit of measurement
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Zooming In and Out on the Graph

Zooming In and Out on the Graph with Mouse

With the left button drag the mouse to outline the area you want to zoom in on.
By right clicking on the graph, the Menu will be displayed. With [Return to Original Size] 
or [Step-by Step Return to Original] you can return both the vertical and horizontal axis 
back to show the entire graph.
*These operations can be carried out via commands in the [Graph] Menu or by clicking 
icons in the Toolbar as above.

With the left button drag the mouse to 
outline the area you want to zoom in 
on.

With the mouse, right click on the graph 
and select [Return to Original Size] in 
the pop-up Menu that appears.

Zoom In Zoom Out

About the Horizontal Axis

The entire graph shows in the horizontal axis the recording start data and recording 
fi nish data for channels 1~8. This represents the full scale of the horizontal axis.

About the Vertical Axis

The farthest you can zoom out on the graph is to the display that shows the lowest 
possible measurement value and the highest possible measurement value in the 
vertical axis for channels 1~8. This represents the full scale of the vertical axis.



74

G
rap

h

[Graph] Menu

[Zoom In / Zoom Out]

Step-by-step zooms in or out one step at a time.

[Move A/B Cursors to the Left / Right]

Simultaneously move the AB Cursors to the left or right. 
With each click the cursor moves the distance of the smallest recording interval. The 
AB cursors can be moved until one of them reaches the left or right edge of the graph. 

[Move Graph Left / Move Graph Right]

While maintaining the present display zoom scale, moves the horizontal axis to the 
left or right.
The movement range is the full scale of the horizontal axis which begins with the 
earliest recorded data and ends with the latest recorded data for channels 1~8.

[Move Graph Up / Move Graph Down]

While maintaining the present display zoom scale, moves the vertical axis up or down. 
The movement range is the full scale of the vertical axis; that is the lowest possible 
measurement value and the highest possible measurement value for channels 1~8.

[Vertical Axis Settings] (Default is "Auto")

The [Vertical Axis Settings] Dialog Box appears where you can change settings for 
the vertical axis scale (temperature and humidity). Select either [Auto] or [Manual]. 
(These operations can be carried out by clicking the [Vertical Axis Settings] icon in 
the Toolbar.

Auto: 

The vertical axis will automatically be 

changed according to the values of the 

data.

Manual: 

You can set the upper and lower values of 

the vertical axis scale.

Check [Auto] or [Manual].
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Data List Display
Shows all recorded data displayed in the graph as a list. Click [Data List Display] in the 
[View] Menu. (The same window can be displayed by clicking on the [Data List Display] 
icon in the Toolbar.) You can view all the recorded data including time and date as a list. 
The green colored dates and times are those that fall within the High, Low, Avg. 
Calculation Range.

[Date / Time] Button
By clicking this button, you can shift the display between the recorded date 
and the amount of elapsed time since recording started.

Recorded Date 
and Time

[Date/Time]
Button

Scroll bar

Elapsed Time
[Date/Time]

Button

Scroll bar

     Color Coded Display
GREEN : Dates and times which fall within the calculation range for determining 

high, low and average measurements
BLACK  : Dates and times outside the calculation range for determining high, low 

and average measurements
RED : Highest Value BLUE : Lowest Value PINK : Average Value

Move to Highest Value / Move to Lowest Value

By right clicking on the Data List 
Display, a Menu will appear. Click 
[Move to Highest Value] or [Move to 
Lowest Value] to move to the Highest 
or Lowest values. By dragging the 
Scroll Bar up and down you can view 
the corresponding part of the 
displayed data in the list.



76

G
rap

h

[Print Preview]

By clicking, the List Print Preview Dialog Box will appear. 
After confirming, click the [Print] button to start the printing.

[Font]

Changes can be made to the Fonts used in the Data List Display. Changes made here 
will not take effect Fonts used in printing.

[Show Lines]

Divides fi elds of data (channels) by lines

[Change Colors]

Make changes to the letter and background colors used in the Data List. Changes made 
here will not effect colors used in printing

Switching the Graph Display Mode
It is possible to hide or view the data graph for selected channel(s) and change the 
colors of data display. Select the commands in the [View] Menu to make these settings.

[Change Channel Colors in Data Display]

Change to black and white or change the colors of the detailed info list for each channel 
that appears below the graph area. (The same operation can be done by clicking on the 
[Changing Colors of Data Display Area] icon in the Toolbar.)

[Selected Channel Graph ON/OFF]

Hide or view the data graph for selected channel(s). By moving the mouse to [Selected 
Channels Graph ON / OFF] in the [View] Menu, the channel numbers are displayed. 
Those channels with a check mark next to the number will be displayed in the Graph. If 
you wish to only hide the data graph for that channel, remove the check.

Checkmark for hiding or 
viewing the data graph 
for selected channel(s)
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The same operation can be done by clicking on the [Channel Number] icons in the 
Toolbar. Click the channel No. of the channel you wish to view.

Those channels with a check mark next to 
the number will be displayed in the Graph.

High, Low, Avg. Calculation Range
Set the calculation range for determining high, low and average measurements. If no 
setting is made the values within the entire graph will be used as the calculation range.

[OK] Button

[Entire Graph]
Button

Enter the numerical values

1. Select [Set High, Low, Average Calculation Range] in the [Tools] Menu to open the 
settings window.

(This settings window can be opened by clicking the [Set High, Low, Average 
Calculation Range] icon in the Toolbar.)

2. In the [Set New High, Low, Avg. Calculation Range] box, the dates and times that 
appear are those of the AB Cursors when the dialog box is opened.

On the graph display, the calculation range that you have set will be displayed.

3. Change the range by entering the desired dates and times and click [OK]. From 
that point the High, Low and Average readings will be calculated within that range.

The graph display will also show only that data within the calculation range.

[Entire Graph] Button

By clicking the [Entire Graph] button, the dates and times in the [New High, Low, Avg. 
Calculation Range] box will display those of the entire graph.
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Editing Recording Conditions
Change channel names and/or adjust recording start times. Select [Edit Recording 
Conditions] in the [Tools] Menu to open the editing window.
(This editing window can be opened by clicking the [Edit Recording Conditions] icon in 
the Toolbar.)

Channel Number

[OK] Button

Enter letters and 
numerical values

[Restore]
Button

1. By clicking the Channel Number you wish to edit, the [Name] and [Started Date / 
Time] in the "Edit Items" display will show info for that channel number.

2. Enter the [Name] and [Started Date / Time] in the "Edit Items" and click the [OK] 
button.

Name: Up to 32 letters can be entered.

3. If you wish to continue to change other channels, repeat the process as in 1 and 2.

[Restore] Button

By clicking this button, the settings will return to those when the dialog box was 

opened.
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Re-ordering Channel Data
You can re-order the data during graph display. Select [Re-order Channel Data] in the 
[Tools] Menu to open the settings window.
There are two methods to use when re-ordering channels: [Re-order by Dragging a 
Channel Number] and [Specify the Channel Numbers to be Moved].

Ex : If you wish to move Ch.3 to Ch.7

Re-order by Dragging a Channel Number

[OK]
Button

[Restore]
Button

Drag the channel number you 
wish to move (Ch 3) to the newly 
desired channel number position 
(Ch 7) and drop it. Click the [OK] 
button to complete the settings.

Specify the Channel Numbers to be Moved

Set as such: "From"  Ch.3 
(original position), "To"  Ch.7 
(desired position); then click the 
[Re-order] button. Click the [OK] 
button to complete the settings.

[Re-order]
Button

[OK] Button

After making the necessary settings, by clicking the [OK] button, the channels will be 
re-ordered and the graph will be re-drawn.

[Restore] Button

This command will become invalid after the settings procedure has been completed 
and the [OK] button has been clicked. If you wish to restore channels, please re-order 
channels again by following the above procedures.
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Erasing Selected Channel Data
You can erase selected channel data from the graph. Select [Erase Selected Channel 
Data] in the [Tools] Menu to open the settings window.

[OK]
Button

Put a check on the 
check box

[OK] Button
By clicking on the [OK] button, the selected data will be erased and the graph will be 
re-drawn.
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Changing Graph Colors and Widths of Lines
It is possible to change colors for the background, graph and scale lines and also 
change the width of the data lines and the scale lines. In the [Tools] Menu, select [Change 
Graph Colors] to open the settings window.

[OK] Button

Color-customizable Items
Data Line Colors (Channel No.1–8)  Graph Background Color
Scale Line Colors  Zoom Box Color  AB Cursor Color

Color Sample

[Default]
Button
[Line Width...]
Button

                  

1. Click the channel number of which you wish to change the color and the [Color 
Settings] dialog box will appear. Select a standard color or create a desired color.

2. In order to change the width of the lines, click the [Line Width] button to open the 
[Graph Line Width Settings] dialog box where you change the width of the data 
lines and the scale lines. (See diagram below)

3. By clicking the [OK] button, the settings will be completed and the graph will be 
re-drawn.

[Default] Button
By clicking the [Default] button, you will return to the color settings when the software 
was opened.

[Line Width] Button
Change the widths of the graph lines in the display and for printing.

For Display: Settings for Display For Printing: Settings for Printing
Graph: Width of the Graph Data Lines Scale: Width of the Scale Lines
Clicking the [Default] button return the line widths to their factory default settings.

For Display For Printing

[OK]
Button

[Default] Button
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Shift Unit (  / F)
Clicking on [Shift Unit (  / F)] in the [Tools] Menu will shift the unit of display between 
Celsius ( ) and Fahrenheit ( F). You can automatically change the temperature unit 
scale in the graph display and in the channel info list.

Copy Display to Clipboard
By clicking [Copy Display to Clipboard] in the [Tools] Menu, you can copy the currently 
displayed window to the clipboard and make use of the graph by pasting to other 
software. By copying data to the clipboard, the previously saved data contents will be 
overwritten with the new contents.

Print Preview and Print

Print Graph / Graph Print Preview

Print the graph in the current display. Printing will occur with the same aspect ratio as in 
the currently displayed graph. The image of the graph to be printed can be viewed in 
the Print Preview Display before printing ([File] Menu – [Graph Print Preview]).
If you wish to carry out printing without checking the preview window, click on the [Print] 
icon in the toolbar or click [Print Graph] in the [File] Menu.

Display Data List Preview and Print

Carry out the printing of a data list by opening Data List Display.

1. By right clicking on the Data List Display, the Menu will appear. Click [List Print / 
Preview] in the Menu and the [List Print Preview] window will be displayed.
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2. After confi rming, click the [Print] button in the Preview window to start the printing.

[Print] 
Button

[Print Preview] window

Page Number / Total Number of Pages 
and Percent of Enlargement / Reduction

Other Buttons
(See below)

Other Buttons

[Previous] Button Preview the previous page.
[Specify P] Button Specify the page you wish to preview in the [Specify Page to 

be Viewed] box and a preview of that page will appear.
[Next] Button Preview the next page.
[Reduce] Button Reduce the currently displayed page.
[Enlarge] Button Enlarge the currently displayed page.
[Close] Button Close the Print Preview display and return to the Main Window.
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Multi-scale Graph

This software, Multi-scale Graph is designed to allow you to view simultane-
ous display of graph channels with different scales such as temperature, 
humidity, voltage, pulse and moisture data in one window. 

The [Multi-scale Graph] program will read data fi les that have been created 
from the downloaded data from the loggers and to help you analyze that data 
will allow you to create graphs, data lists, text fi les and print data. It is also 
possible to scroll across the graph and make scale settings for each channel.

From the [File] Menu, select [Open Multi-scale Graph] to open.

- For detailed information about the compatible data fi le types for the [Multi-scale 
Graph], see the Multi-Scale Help Menu. 

- If a check has been placed next to [Automatically show graph] in ([Download Data] 
tab – [Detailed Settings] – [Post Downloading Settings]), the graph will automatically 
be displayed after downloading. (The default setting is for a check to be next to 
[Automatically show graph].)



85

Main Window Names and Functions

1.Graph Area

The area in which the Graph is displayed. The horizontal axis shows time and the 
vertical axis shows voltage data in units as calculated by the selected conversion 
equation. 

2.A and B Cursor Bars

By clicking the arrow buttons at the left and right of the bar, you can simultaneously 
move the A/B cursors. Click and drag the A or B button on the bar to move the cursor 
to the left or right.

3.A and B Cursor Position Information

The approximate date and time for the A and B cursor positions and the time 
difference between the A cursor and the B cursor is displayed.

4.Channel Info Display

The detailed data info for each channel 1 to 8 is displayed below the Graph Display. 
See the next page for details.

5.Hide or View the Vertical Scale for each Channel

It is possible to hide or view the scale on the graph for each channel.
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6.Vertical Axis Scale for each Channel

( )

The vertical axis scale can be displayed for each channel into which data has been 
read. By clicking the arrow at the corners of the gauge bar you can scroll up or down 
on the current display while maintaining the present zoom.

7.Menu Bar

Menus are lined up which contain various commands. They are used to view data or 
to make settings for the various functions in each menu.

8.Toolbar (Icons)

Buttons appear for frequently used commands.

9.Horizontal Gauge Bar and Button for Moving Horizontal Axis

The time axis moves by clicking these arrow buttons at the left and right of the bar. By 
dragging the gauge you can move left and right to the data you want to be displayed.

10.Vertical Gauge Bar and Button for Moving Vertical Axis

The vertical axis moves up or down by clicking these arrow buttons at the upper and 
lower sides of the bar. By dragging the gauge you can move up and down to the data 
you want to be displayed.

Channel Info Display Items

Ch [Channel Number] button, Drag the channel name / number you wish to 
move to the newly desired channel name / number position and drop it.

Name Channel Data Name Interval Recording Interval

Sample Number of data CursorA Cursor A position data

CursorB Cursor B position data A<->B Calculated Temp / Humidity 
Difference between Cursor A 
and B

Max. Highest Reading Min. Lowest Reading

Avg. Average Value Unit Unit of measurement

Sum Total Data Value
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Zooming In and Out on the Graph

Zooming In and Out on the Graph with Mouse

With the left button drag the mouse to outline the area you want to zoom in on. 
By right clicking on the graph, the Menu will be displayed. With [Return to Original Size] 
or [Step-by Step Return to Original] you can return both the vertical and horizontal axis 
back to show the entire graph.

With the left button drag the mouse to 
outline the area you want to zoom in 
on.

With the mouse, right click on the graph 
and select [Return to Original Size] in the 
pop-up Menu that appears. 

Zoom In Zoom Out

*These operations can be carried out via commands in the [Graph] Menu or by clicking 

icons in the Toolbar as above.
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Data List Display
Shows all recorded data displayed in the graph as a list. Click [Data List Display] in the 
[View] Menu. You can view all the recorded data including its time and date as a list. The 
green colored dates and times are those that fall within the High, Low, Avg. Calculation 
Range. (The same operation can be carried out by clicking on the [Data List Display] 
icon in the toolbar.)

[Date / Time] Button

By clicking this button, you can shift the display between the recorded date and the 
amount of elapsed time since recording started.

Recorded Date 
and Time

[Date/Time]
Button

Scroll bar

Elapsed Time
[Date/Time]

Button

Scroll bar

Color Coded Display

GREEN : Dates and times which fall within the calculation range for determining 
high, low and average measurements

BLACK  : Dates and times outside the calculation range for determining high, low 
and average measurements

RED : Highest Value BLUE : Lowest Value PINK : Average Value

Move to Highest Value / Move to Lowest Value

By right clicking on the list, the Menu will be displayed.

By right clicking on the Data List Display, 
a Menu will appear. Click [Move to 
Highest Value] or [Move to Lowest Value] 
to move to the Highest or Lowest values. 
By dragging the Scroll Bar up and down 
you can view the corresponding part of 
the displayed data in the list.
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Changing Graph Display Mode
It is possible to hide or view the data graph for selected channel(s) and the scales in the 
Graph Area. From the [View] menu, select [Scale Display ON/OFF] to make the 
necessary settings.
*The settings here are the same as those in "Temperature / Humidity Graph".

High, Low, Avg. Calculation Range
Set the calculation range for determining high, low and average measurements. If no 
setting is made the values within the entire graph will be used as the calculation range. 
Select [Set High, Low, Average Calculation Range] in the [Tools] Menu to make the 
necessary settings.
(This settings window can be opened by clicking the [Set High, Low, Average 
Calculation Range] icon in the Toolbar.)
*The settings here are the same as those in "Temperature / Humidity Graph".

Editing Recording Conditions
Change channel names and/or adjust recording start times. Select [Edit Recording Con-
ditions] in the [Tools] Menu to make the necessary settings.
(This editing window can be opened by clicking the [Edit Recording Conditions] icon in 
the Toolbar.)
*The display layout of the "Multi-scale Graph" is different from that of "Temperature / 
Humidity Graph". However, the settings here are the same as those in "Temperature / 
Humidity Graph". See p.78 for details.

Re-ordering Channel Data
You can change the order of the data in channels as viewed in the graph. Select [Re-order 
Channel Data] in the [Tools] Menu to make the necessary settings. 
*The display layout of the "Multi-scale Graph" is different from that of "Temperature / 
Humidity Graph". However, the settings here are the same as those in "Temperature / 

Humidity Graph".

Multi-scale Graph [Re-order Channel Data] Window

Re-order by 
Dragging 
a Channel 
Number.

Re-order by 
Selecting Two 
Channels to 
Re-order.

[Change 1 and 2] 
Button
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Erasing Selected Channel Data
You can erase the selected channel data from the graph. Select [Erase Selected 
Channel Data] in the [Tools] Menu to make the necessary settings.
*The settings here are the same as those in "Temperature / Humidity Graph".

Merging Channel Data
Use this function when you wish to merge one channel of data with another channel of 
data. Select [Merge Channel Data] in the [Tools] Menu to open the editing window.

Ex: If you wish to merge Ch.3 with Ch.7

[Merge]
buton

1. Select channel 7 from the selection box at the left side. Upon selection, the 
channels, which are capable of being merged, will appear in a list on the right. 
Select channel 3.

2. By clicking the [Merge] button, the Ch.3 Data on the right will be added to the end 
of the Ch.7 Data. 

Please make sure to select a channel with older data for the left side.

NOTE:

- The channel data selected for the box on the right will not be deleted. If you wish to 
delete, go to [Erase Selected Channel Data] in the [Tools] menu to delete that data.

- The following data cannot be merged.
The total number of readings after merging exceeds 16,000 data readings. / The 
recording intervals are different. / The data is of different types. / The recording 
intervals are different. / The measuring times overlap (This can be adjusted by 
using the [Edit Recording Conditions]. See the previous page for details.)
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Setting Vertical Axis Display Range
Set the Vertical Axis Scale Range to Auto or Fixed for each channel. Make settings to 
have the Vertical Axis Scale Range automatically assigned according to type of data or 
have it remain fi xed at the same values every time it is opened. In the [Tools] Menu, 
select [Set Vertical Axis Display Range] to open the settings window.

[OK] Button 

Select [Fixed] and enter numerical 
values.

Check here, if you wish to make 
all of the settings the same. 

1. Put a check next to [Fixed] for the channel(s) you wish to make settings for and 
enter the top and bottom values.

2. If you wish to use fi xed values for all channels, choose fi xed values for Ch.1 and 
put a check next to [Make all settings same as Ch. 1]. Then the settings will 
become the same for all other channels.

3. Click the [OK] button to fi nish the setting process.

NOTE:

- If you have chosen fi xed values for all channels, the data graph lines may, under 
certain circumstances, stick out of the graph. Settings for the upper limit must be 
40,000 or lower and settings for the lower limit must be -40,000 or higher.

- The values assigned here will be active and used when saving the graph to a fi le. If 
you wish to have the vertical axis scale range automatically assigned, by clicking 
"AUTO" for each channel, the vertical scale will automatically be determined and 
set according to the upper and lower values of the data being viewed.
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Scale / Unit Conversion
It is possible to make settings for the conversion of units and scales for each channel of 
downloaded data. This can be used when no conversion formula settings were made 
before recording or when you wish to make changes to the conversion formula that was 
set in the Scale Settings Display. 
In the [Tools] Menu, select [Scale / Unit Conversion] to open the settings window.

Example of "[Designate by 2 points] Tab" display

Current conversion formulas and units 
are displayed here. "y" indicates the 
data after conversion, and "x" 
indicates the voltage entering from the 
sensor.

[OK] Button

[Return all Conversions] 
Button

[Designate by y=ax+b] Tab

Conversion info

[Designate by 2 points] Tab

1. Select to use 2 voltage points to convert the scale, by clicking on the [Convert 
using 2 points] tab or use the simple conversion equation by clicking on the [Convert 

with y=Ax+B] tab.

2. Make settings for the conversion equation and unit.

3. Click the [OK] button to fi nish the setting process. By clicking the [Return all 
Conversions] button, the settings for all channels will return to those when the 
dialog box was opened.
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Changing Graph Colors and Widths of Lines
It is possible to change the colors of the graph background, the lines, the AB cursors 
and the width of the lines. You can make settings for both display and for printing. 
In the [Tools] Menu, select [Change Graph Colors] to open the settings window.

Other Buttons
(See below)

Memo
setting area

[Change Channel 
Number Color] Button

[Default] Button

[Change Width 
of Graph Data 
Lines] Button

Image Preview

[Save] Button [View] Button

1. In the "Memo" setting area, select either "Display" or "Print". Click the [Save] button 
to save the settings, and by clicking the [Load] button, you can call up a saved 
pattern. One pattern can be stored for each application.

2. If you wish to make changes to the graph colors, line types, or line widths, click on 
the [Channel No.] button fi rst and then click on the topic you wish to make changes 
to. See below for details about each button.

Image Preview

This area will show the display with the newest settings. An image showing the new 
settings will appear and it can be used to check the graph. 

Changing the widths of the graph lines: [ ][ ] Button

Change the width of the data lines. Please use this feature when printing with a 
monochrome laser printer or any other printer where narrow lines may be diffi cult to see. 
Each click of the [ ] button will make the lines wider and each click of the [ ] button 
will make them thinner. Click on the [Channel No.] button fi rst and then click the [ ][ ] 
button to change the widths.
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[Graph] Button

Change the color of that channel's data lines. The standard Windows color selection 
dialog box will appear. Choose the standard color you want or make any desired colors. 
Click on the [Channel No.] button fi rst and then make settings to the colors of the graph 
lines.

[Line Type] Button

You can select from fi ve types of lines such as a standard line or a dotted line. (However, 
if the line has been made wider by the [ ][ ] button it will appear as a standard line 
no matter the setting.) Click on the [Channel No.] button fi rst and then make settings to 
the types of the graph lines.

[Background] Button

Change the graph's background color. The standard Windows color selection dialog box 
will appear. Choose the standard color you want or make any desired colors.

[Scale] Button

Change the horizontal and vertical graph scale line colors. The standard Windows color 
selection dialog box will appear. Choose the standard color you want or make any 
desired colors.

[AB Cursor] Button

Change the AB Cursor line colors. The standard Windows color selection dialog box will 
appear. Choose the standard color you want or make any desired colors.

[Scale Value] Button

Change the Scale Value colors. The standard Windows color selection dialog box will 
appear. Choose the standard color you want or make any desired colors.

[Default] Button

Returns the colors to the default [Multi-scale Graph] colors. 
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Print Preview and Print

Print Graph / Graph Print Preview

The image of the graph to be printed can be viewed in the Print Preview Display before 
printing ([File] Menu – [Graph Print Preview]). When carrying out printing, click the [Print] 
button in the Preview window to start the printing. (The same operation can be done by 
clicking on the Print Preview icon in the Toolbar.)

Display the Data List Preview and Print

Carry out the printing of a data list by opening the Data List Display.

1. By right clicking on the Data List Display, the Menu will appear. Click [List Print / 
Preview] in the Menu and the [List Print Preview] window will be displayed.

2. After confi rming, click the [Print] button in the Preview window to start the printing. 
By using the Print Preview Display Toolbar you can change the page being 
displayed, enlarge or reduce the display as desired, and start printing.
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Event Viewer

Here you can manage (view data lists, print, and save as text fi le) recorded 
event data.

This software is designed as a tool to allow you to view event time data for 
RVR-52A data fi les (*.rp7). With Event Viewer you can view Recorded Event 
Time Data in a List (up to 64 channels), Print the List, or Save as Text File. 
From the [File] menu, select [Open Event Viewer].

*If a check has been placed next to [Automatically show graph] in ([Download Data] tab 
– [Detailed Settings] – [Post Downloading Settings]), the graph will automatically be 
displayed after downloading. (The default setting is for a check to be next to [Automatically 
show graph].)
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Main Window Names and Functions

1.Data Window

In the data window are displayed the Data Number, Channel Name, Recorded Date 
and Time, Rising Edge/Falling Edge. 

2.Menu Bar

Menus are lined up which contain various commands. They are used to view data or 
to make settings for the various functions in each menu.

3.Toolbar (Icons)

Buttons appear for frequently used commands.

4. (Rising Edge or Falling Edge)

 Shows Polarity Changes from Low to High. (Rising Edge)
 Shows Polarity Changes from High to Low. (Falling Edge)

 Shows the Simultaneous Occurrence of Rising and Falling.

5.Scroll Bar

By using the up and down scroll bar you can move the display position to the desired 
one.
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Changing the Event Viewer Method of Display
By using the commands in the [View] Menu, you can shift the display to view the 
recorded data. 

[Shift Display]

You can shift the display to view either by the recorded date/time or by the 
elapsed time from the last recorded data. Select [Shift Display] in the [View] 
Menu to make these settings.

Example of "Date/Time" display Example of "Elapsed Time" display

[Shift Descending / Ascending   ]
Shift the order to display the data in descending order or ascending order. In 
"Descending order", event data is arranged in order from the newest to the oldest. In 
"Ascending order", event data is arranged in order from the oldest to the newest. 

The same operation can be done by clicking on the [Display 
in ascending / descending order] icon in the Toolbar. 
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File Info

View fi le info about data in the currently displayed data list. 

By clicking [File Info] in the [View] Menu, a Dialog Box will appear. 
(The same operation can be carried out by clicking on the [File Info] icon in the toolbar.)

File Name File name of data currently in display

Path Location where fi le is saved

Date Created The date and time when the data fi le was created

CH.Info Channel Number, Recording Method and Data Count

Open multiple sets of data
It is possible to open and display a number of data windows at the same time. Also, 
data can be displayed in a systematic manner in the window. This is particularly helpful 
when you wish to compare data. Make selections from the [Window] Menu.

[Open New Window]

Open a new window with the same contents as in the currently opened window. It is 
possible to simultaneously display different parts of the same fi le.

[Stacked Display] / [Arranged Display]

Display all of the open fi les in windows layered on top of one another or display all of 
the open fi les in windows so they are not stacked directly on each other. Particularly by 
using [Arranged Display], you can compare data more easily.

[Put Icons in Order]

When a plural number of windows are opened and minimized (iconized), this arranges 
the icons in order in the lower left corner.
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Print Preview and Print
Select the channels of data you wish to print from the channels displayed in the Event 
Viewer; view them in the Print Preview, and Print. In the [File] Menu, select [Print 
Preview and Print]. 

[Select Channel for Printing] Window

[OK] Button

1. In the [Select Channel for Printing] window, select the channels you wish to print 
and click the [OK] button.

- The same operation can be done by clicking on the Print Preview and Print icon in 
the Toolbar.

2. After confi rming, click the [Print] button to start the printing.
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Other Functions

Saving Recorded Data
If you have checked [Automatically show graph.], make sure to save data after 
displaying the graph or editing any data. In the [File] Menu, select the way to save data. 

Temp / Humidity Graph or Multi-Scale Graph

[Overwrite All Data]

Will save any changes to fi le without changing File Name and Saving Location. 
If you are saving the data for the fi rst time, the [Assign Data File Name] Dialog Box 
will appear. Please enter an appropriate fi le name and save. 

*The same operation can be carried out from [Save] in the Toolbar.

[Save All Data as ]

Save all downloaded or edited data to a new fi le. After data has been downloaded, 
the "Assign Data File Name" Dialog Box will appear wherein you can save the data to 
a specifi ed fi le. Save by assigning a fi le name and location.
(Only with the Temperature / Humidity Graph, can the same operation be carried out 
from [Save Data as ] in the Toolbar.)

[Save Displayed Data]

Save the data currently in the displayed time range (Horizontal axis is time range) into 
a new fi le. After data has been downloaded, the "Assign Data File Name" Dialog Box 
will appear wherein you can save the data to a specifi ed fi le. Save by assigning a fi le 
name and location.

Saving Data for Event Viewer

[Save All Data as ]

Click [Save Data as...] in the [File] Menu. The "Assign Data File Name" Dialog Box will 
appear wherein you can save the data to a specifi ed fi le. Save by assigning a fi le 
name and location.

*The same operation can be carried out from [Save Data as ] in the Toolbar.
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Saving Data as Text File
By saving the recorded data as text fi le, you can create a fi le type that can be read by 
common spreadsheet software. You can save the entire graph data or the data currently 
displayed in the graph in Text File (CSV) Format. (File will have extension [.txt])
However, [Event Viewer] cannot read text type fi les.
Select [Save Data in Text File] in the [File] Menu to open the settings window.

Creating Text File for Temp / Humidity Graph or Multi-Scale Graph

[OK] Button

Select Delimiters.

Select Range 
to be Saved.

1. By selecting the [Delimiters] and [Range to be Saved], and clicking [OK], a dialog 
box will appear where you can choose text fi le name.

Delimiters : Select to divide data with a comma, tab, space, or a 
semi-colon. Comma, Tab, Space, and Semi-colon are 
codes used by common spreadsheet software, such 
as Excel and Lotus, when reading Text File to divide 
cells.

Range to be saved : Choose to save all data or to save range of data 
displayed in graph.

2. Designate the fi le name and the location to which the fi le should be saved and 
click [Save] to create and save the data as a Text File document.
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Creating Text File for Event Viewer

(Only for the Event Viewer, this settings window can be opened by clicking the [Save as 
Text File] icon in the Toolbar.)

[OK] Button
Select the 

Text File 
Type

[Designate File]
Button

1. By selecting the [Delimiters] (See the previous page), and clicking [Designate 
File], the [Save as ] dialog box will appear where you can specify the saving 
location.

2. Designate the fi le name and the location to which the fi le should be saved and 
click [Save] to return the window to the previous [Save Data in Text File] dialog 
box. Click the [OK] button to fi nish the creation of the text fi le document.
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Opening a Saved File
Opens already existing data fi les. It is possible to open more than one fi le at a time. 
While holding down the <Ctrl> key click the fi les you wish to open. For detailed 
information about the data fi le types, see the Help Menu for each type of Graph.
In the [File] Menu, select [Open]. The same operation can also be carried out from [Open 
File] in the Toolbar.

Opening a Saved File for Temp / Humidity Graph or Multi-Scale Graph

Select the location and name of data fi le you wish to open and click [Open] to view the 
data in graph form. 

[Open] 
Button

Selected File Name 
Selected File Info

Select a File

Saved File Location

Opening a Saved File for Event Viewer

Select the location and name of the data fi le you wish to open and click [Open] and a 
list will appear.

[Open] 
Button

Selected File Name 
Selected File Info

Select a File

Saved File Location



105



106

O
th

ers

Others



107

Troubleshooting

Q: The computer won't communicate via the Serial Port. What should I 
do?

A: Try two or three times to fi nd the port connection by using the Auto-
Detect function.

A: Check the connection between the computer and the Unit. Communica-
tion will take place only through the serial port (RS-232C) and will not 
work through the printer port or any other port.

A: Check to make sure that you can control the device via the software.

A: If you have access to another computer, try seeing if communication 
works with the other computer.

A: If you have a computer with energy saving function settings, make sure 
that the serial port has not been turned off. Especially on NEC brand 
PC98 notebook computers the default setting maybe such.

A: Check to make sure that the serial port has not been rendered unusable 
by the BIOS setting.

A: Make sure that the serial port setting has not been made to render the 
port unusable. With some computers, especially all-in-one computers 
the serial port serves as the modem jack. 

How to check 1: Open the Device Manager

For Windows® XP / 2000

1.
2.

In the [Start] Menu, right click on [My Computer] and click on [Properties]. 
In the System Properties Window, click on the [Hardware] tab, then click on 
the [Device Manager] button to view the Device Manager Window.

For Windows Me or 98SE

1.

2.

Open the [Control Panel] and double click on [System]; the system 
properties will be displayed.
Click the [Device Manager] tab to view the Device Manager Window.
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How to check 2

In the [Device Manager], click on [Port (COM&LPT)] and check to see if under 
that appears [Com Port (COM1)] or [Com Port (COM2)]. 
If a port appears, it should be usable.

If a mark [ ] or [ ] appears next to the port, this communication port is 
unusable. If you cannot use a communication port please contact your 
computer company.

To fi nd out more details about an unusable communication port:
Select the port with a [ ] mark, and then click on [Properties] to view the 
details about that port.

A: If your computer has an internal modem, make sure that the communi-
cation port is not being used by it. When the communication port is 
being used as the modem port, that port cannot be used. Either quit 
using the modem or use another port.

Example of modem using 
a communication por t 
(COM 1).

A: Sometimes communication will not work if a switch has been added to 
the serial port (RS-232C) or an extension cable has been added to the 
communication cable.

A: Check to see if some other communication software is in use.

A: If your desktop computer has two serial ports, try connecting the com-
munication cable to the other port and try communicating again.

Q: The date and the time of the recorded data are different from the 
actual date and time. Why?

A: RTR-50 units have no internal clock. When you set up a programmed 
recording start or when you download data, the date and time that are 
shown are taken form your computer's clock. If your computer's clock is 
not correct, it will affect the recorded data.
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Q: Wireless communication cannot be carried out. What should I do?

A: If you are using an RTR-50 as a Relay Unit and a battery to power to the 
Unit, the battery power may be low. Connect the RTR-50 unit to your 
computer and open the [RTR-50 Unit Info] in the [Help] menu. Click the 
[Gather] button, and if the message [Battery Power is low.] appears, 
please change the battery.

A: If you are using the optional serial communication cable (TR-07C), it is 
necessary to incorporate batteries in the Unit or to connect the AC 
adaptor to the RTR-50 Unit. Check to make sure that the setting has 
been made correctly.

A: When communicating via Relay Unit(s), even if communication has been 
cancelled from the computer, wireless communication may still be in 
progress. Wireless communication among Relay Units and between a 
Relay Unit and Remote Units fi nishes automatically. Note however that 
a period exists before a communication is fi nished in which no new wire-
less communication can be started. Please allow enough time for this 
period and try again. Illumination of the Monitor LED on the front of the 
Relay Unit indicates that wireless communication is in progress.
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Specification

RTR-50 for Windows

Compatible Devices RTR-50, RTR-51, RTR-52, RTR-53, RVR-52A

Communication 
Functions:RTR-5

Start Recording (Immediate Start, Programmed Start) / Stop 
Recording / Get Unit Recording Settings (Recording Interval, 
Recording Mode, Remaining Battery Life, Radio Wave Strength, 
Gather Current Readings) / Wireless Recording Start Settings, 
Saving / Download Recorded Data

Communication 
Functions:RVR-5

Start Recording (Programmed Start / Immediate Start) / Stop 
Recording / Get Unit Recording Settings (Recording Interval, 
Recording Mode, Remaining Battery Life, Radio Wave Strength, 
Voltage Measurement Data (Measuring Mode: instantaneous value 
or average value), Pulse Measurement Data (Measuring Mode: 
Rising [Lo to Hi] or Falling [Hi to Lo]) Recording Start Settings, 
Saving / Download Recorded Data via Wireless Communication

Communication 
Functions:RTR-50

Remote Unit and Group Settings / Communication Frequency 
Channel Settings / Monitoring / Warning Monitoring / Sending 
Warning Report Mail / Auto-Download

Other Functions Auto detect of Serial Communication Port and USB Port

Temp/Humidity Graph

Graph Temperature / Humidity Graphs for each Channel (Zoom in/out and 
scroll with mouse or keyboard) 
Change Display Colors for Channels, View / Hide Channels

Data Channel Name, Recording Interval, Number of Data, Highest, 
Lowest and Average, Unit of Measurement
AB Cursor Dates/Times and Temp/Humidity Readings
Calculated Temp/Humidity Difference between Cursor A and B

Number of Channels 8 Channels    Simultaneous Display / Processing
(4 Units for RTR-53 and 8 Units for each RTR-51/52/RVR-52A of 
data can be viewed and processed at one time.)

Other Functions Data List Display / Calculation Range (Time Period) Settings / Edit 
Recording Conditions / Delete Data by Channel / Re-order Data by 
Channel / Vertical Axis Settings
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Multi-scale Graph

Graph Data Graphs for each Channel (Zoom in/out and scroll with mouse 
or keyboard) / Change Display Colors for Channels / Hide or View 
Channels

Data Display Channel Name / Recording Interval / Number of Data / Highest, 
Lowest and Average / Sum / Unit of Measurement / A and B Cursor 
Dates/Times and Measurements / Calculated Differences in 
Measurements between Cursor A and B

Number of Channels 8 Channels    Simultaneous Display / Processing (4 Units for 
RTR-53 and 8 Units for each RTR-51/52/RVR-52A of data can be 
viewed and processed at one time.)

Other Functions Data List Display / Calculation Range(Time Period) Settings / Edit 
Recording Conditions / Delete Data by Channel / Re-order Data by 
Channel / Vertical Axis Settings 

Event Viewer

Data List View Event Time Data List for Each Channel (Zoom in/out and 
scroll with mouse or keyboard) / View Rising (Lo to Hi) Waves and 
Falling (Hi to Lo) Waves

Number of Channels 64 Channels    Simultaneous Display / Processing (Only for 
Recorded Event Time Data with the RVR-52A)

Other Functions Change the LCD Display / Shift between Descending and 
Ascending

Others

Printing Graphs / Data List

Compatible OS Microsoft Windows 98SE / Me English
Microsoft Windows 2000/XP English

PC/CPU IBM Compatible equipped with more than Pentium 90MHz or NEC 
98 Series / USB Communication or Serial Communication is 
possible (RS232-C D-sub 9pin)

Operating 
Environment

A Stable Windows Operating Environment
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RTR-50
Compatible Devices RTR-51, RTR-52, RTR-53, RVR-52A
Functions Wireless Communication: Download Data, Monitoring / Warning 

Monitoring, Start / Stop Recording, Wireless Relay Unit Function
Optical Communication: Download Data / Start / Stop Recording

Power USB bus power, 2 AA batteries, External Power Voltage Input (DC 
5.0-7.0 V) [EIAJ-02 connector]

Interface USB miniB Connector / Serial [Mini serial] (19200bps)
Wireless 
Communication 
Method

FCC Part15 Section249 / IC RSS-210

Wireless 
Transmission Range

About 330ft (About 100m) If direct and unobstructed

Communication Time Wireless Communication: 1 unit of full data takes about 420 
seconds (when Relay Units Not Used) 
When communicating via Relay Units, the approximate time for that 
communication is calculated as follows: "420 seconds + (Number of 
Relay Units x 420 seconds)".
Optical Communication: 1 unit of full data takes about 160 seconds

LED Specifi cations Green LED (Blink during Wireless Communication and PC 
Communication)

Battery Life 6 Months of continued use on two AA alkaline batteries when used 
as Relay Unit for fi ve minutes a day.

Dimensions H 3.78 in (95mm) W 2.60 in (65mm) D 0.98 in (24.5mm)
Weight Approx. 2.12 oz (60g) *Batteries not included
Operating Voltage 2.5V to 7.0V
Consumption 
Current

Approx. 50mA (Wireless Communication)

Operating 
Environment

Temperature: -10 to 60  (-30 to 60  when external power 
connected)
Humidity: 20 to 80%RH (No condensation)

Accessories 
included

USB Communication Cable 1, 
RTR-50 for Windows Software CD-ROM 1, Users Manual 1

Optional 
Accessories

Serial Communication Cable TR-07C
AC Adaptor (For details, contact your local representative or dealer.)
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For product information or questions contact us at:

5652-169 Sasaga Matsumoto, Nagano Japan 399-0033
Tel:+81-263-27-2131  Fax:+81-263-26-4281  

E-mail: overseas@tandd.co.jp

Offi ce Hours: Monday to Friday 9:00-12:00/13:00-17:00
                                                                    (GMT +9:00 Tokyo Time)     

Website/T&D Online

We have opened an English Website called "T&D Online" for your 
convenience. Here you can fi nd information about our company, 
news, product, news, products, upcoming events, software and 
user's manuals downloads, as well as, other support. Please stop by 
and see what we have to offer.

http://www.tandd.com/

 Wireless Communication Port RTR-50
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Wireless Communication Port  RTR-50  Warranty

Customer's name:

Address:

Phone No.:

Dealer's name:

Address:

Phone No.:

Guarantee period 12 months from date of purchase

Date of purchase

  Statement of Limited Warranty
1.  This product is warranted to be free from defects in materials and workmanship for a period of one (1) 

year following the date of purchase. Should the product fail to operate per specifi cation in normal use 
during this period T&D will repair the unit or provide a replacement free of charge. T&D will not accept 
returns for any reason other than defects during the warranty period, and will not accept any product that 
has been misused, dropped, abused or inappropriately used or mistreated at any time.

2.  This warranty is strictly limited to repair or replacement-in-kind for defective product. T&D makes no other 
warranty, either express or implied, and will not accept liability beyond the remedies stated herein. 
Specifi cally, T&D will not accept liability for direct, indirect, special, consequential or incidental damages 
arising from the use of this product.

3.  Customers wishing to submit a defective product for repair or replacement during the warranty period 
should fi rst contact the dealer from whom it was originally purchased. After receiving a return 
authorization the defective product should then be packaged along with a description of the diffi culties 
being experienced, proof of purchase and all included accessories and materials, and return it to the 
dealer. In the event of diffi culty contacting the original dealer, customers should contact the nearest 
authorized T&D sales representative. A list of these can be found on the company's website, www.tandd.
com, or it can be obtained by contacting TandD US directly.

4.  This limited warranty statement gives the customer specifi c legal rights. The customer may also have 
other rights which vary from state to state in the United States, from province to province in Canada, and 
from country to country elsewhere in the world. To the extent this limited warranty statement is 
inconsistent with local law, this statement shall be deemed modifi ed to be consistent with such local law.

5.  For further information relating to product repair or replacement, or for other service questions after the 
termination of the warranty period, customers should contact their local authorized T&D sales 
representative.
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